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பாடம் – 1 

அடடாப் டபஜ்டமக்கர் 

பகுதி - அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 DTP என்பேன் விரிவாக்கம் அ) Desktop Publishing 

2 _________ என்பது ஒரு DTP தேன்தபாருளாகும்.  ஆ) PageMaker  

3 எந்ே பட்டியில் New கட்ைலள இைம்தபற்றுள்ளது? அ) File menu  

4 Page Maker சன்னல் திலரயில் கருப்பு நிற எல்லைக் மகாட்டிற்கு தவளியில் 

இருக்கும் பகுதி _________ என அலைக்கப்படும். ஆ) pasteboard  

5 PageMaker ஆவணத்லே மூடுவேற்கான விலசப்பைலக குறுக்கு வழி _________  

ஈ) Ctrl+W  

6 _________ கருவி ஆவணத்தின் ஒரு பகுதிலயப் தபரிோக்கிப் பார்க்கப் 

பயன்படுகிறது.  இ) Zoom tool  

7 தபட்டிகள் வலரவேற்குப் பயன்படும் கருவி _________  இ) Rectangle 

8 Place கட்ைலள _________ பட்டியில் இைம்தபற்றிருக்கும். அ) File  

9 முழு ஆவணத்லேத் மேர்ந்தேடுக்க விலசப்பைலகயில் _________ குறுக்கு வழி 

சாவி மசர்ோனத்லே அழுத்ே மவண்டும். அ) Ctrl+A  

10 எழுத்து வடிவூட்ைல் கீழ்க்கண்ைவற்றில் எந்ே பண்புகலளப் தபற்றிருக்கும்?  

ஈ) All of these  

11 உலரலய பதிப்பிக்க பயன்படும் கருவி எது? அ) Text tool  

12 PageMaker இல் ஆவணத்லே அச்சிைப் பயன்படும் விலசப்பைலக குறுக்கு வழி 

_________ ஆ) Ctrl +P  

13 அமைாப் மபஜ்மேக்கர் என்பது  பக்கவடிவலேப்பு தேன்தபாருளாகும்.  

14 ேலைப்புப் பட்லை மபஜ்மேக்கர் ஆவணத்தின் மேல்பகுதியில் இருக்கும்.  

15 ஆவணத்லே மேலும் கீழுோகவும், இைது ேற்றும் வைது புறோகவும் நகர்த்துவலே 

திலர உருளல் பட்லைஎன்கிமறாம்.  

16 எலிப்ஸ் கருவி வட்ைம் வலரவேற்குப் பயன்படுகிறது.  

17 Layout பட்டிலயக் கிளிக் தசய்து Insert Pages விருப்பத்லேப் தபறைாம். தபாருத்துக.  

18 தபாருத்துக 

 அ)  Cut    - (iii) Ctrl+X  

ஆ) Copy  - (iv) Ctrl+C  

இ)  Paste - (ii)  Ctrl+V 

ஈ)   Undo  - (i)  Ctrl+Z  

19 கீழ்க்கண்ைவற்றில் தபாருந்ோே ஒன்லறத் மேர்ந்தேடு. 

 i.   Adobe PageMaker, QuarkXPress, Adoble InDesign, Audacity  

ii.   File, Edit, Layout, Type, Zip  

iii.  Pointer Tool, Line Tool, Hide Tool, Hand Tool 

iv.    Bold, Italic, Portrait, Underline.  
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20 கீழ்க்கண்ைவற்றில் சரியான கூற்லறத் மேர்ந்தேடு. 

 i.     அ) சுட்டியின் மூைம் ேட்டுமே உலரலயத் மேர்ந்தேடுக்க முடியும்.  

      ஆ) சுட்டி ேற்றும் விலசப்பைலகயின் மூைம் உலரலயத் மேர்ந்தேடுக்க  

             முடியும்.  

ii.  அ) DTP என்பேன் விரிவாக்கம் Desktop publishing.   

      ஆ) DTP என்பேன் விரிவாக்கம் Desktop publication.  

 

21 கீழ்க்கண்ைவற்றில் சரியான இலணலயத் மேர்ந்தேடு. 

 i. அ) Edit Cut  

  ஆ) Edit New 

ii. அ) Undo Copy  

  ஆ) Undo Redo 

 

பகுதி - ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 Desktop publishing என்றால் என்ன?  

 ➢ தைஸ்க்ைாப் பப்பிளிசிங் (சுருக்கோக DTP) என்பது DTP தேன்தபாருலளப் 

பயன்படுத்தி ஆவணங்களுக்கான பக்கங்கலள வடிவலேப்பு தசய்வோகும். 

 

2 DTP தேன்தபாருள்களுக்கு எடுத்துக்காட்டுகள் ேருக.  

 ➢ அமைாப் மபஜ்மேக்கர் (Adobe PageMaker) 

➢ அமைாப் இன்டிலசன் (Adobe InDesign),  

➢ குவார்க் எக்ஸ்பிரஸ் (QuarkXPress).  

 

3 மபஜ்மேக்கர் தேன்தபாருலள திறப்பேற்கான வழிமுலறகலளக் கூறு.  

 ➢ விண்மைாஸ் 7 இயக்க அலேப்பில், Start > All Programs > Adobe > PageMaker 

7.0 > Adobe PageMaker 7.0 என்ற வரிலசயில் கிளிக் தசய்து அமைாப் 

மபஜ்மேக்கலரத் திறக்கைாம். 

 

4 மபஜ்மேக்கர் தேன்தபாருளில் ஒரு புதிய ஆவணத்லே எவ்வாறு திறக்கைாம்?  

 ➢ File->New (அல்ைது) Ctrl+N என்பலே கிளிக் தசய்ய மவண்டும். 

➢ உலரயாைல் தபட்டி மோன்றும்.  

➢ மேலவயான அளவுகலள உள்ளீடு தசய்ய மவண்டும். 

➢ OK தபாத்ோலன அழுத்ே மவண்டும். 

 

5 ஒட்டுப்பைலக என்றால் என்ன?  

 ➢ அமைாப் மபஜ்மேக்கரில் கருப்பு நிற எல்லைக் மகாட்டிற்கு தவளியில் உள்ள 

பகுதி ஒட்டுப்பைலக (Pasteboard) என அலைக்கப்படுகிறது. 

 

6 மபஜ்மேக்கரில் உள்ள பட்டிப்பட்லை பற்றி குறிப்பு எழுதுக. 
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 ➢ மபஜ்மேக்கரின் பட்டி பட்லையில் File, Edit, Layout, Type, Element, Utilities, View, 

Window, Help மபான்ற பட்டிகலளக் தகாண்டுள்ளது.  

➢ ஒரு பட்டியில் கிளிக் தசய்ோல் பை கட்ைலளகள் ேற்றும் 

துலணப்பட்டிகளுைன் கூடிய துலண பட்டியல் மோன்றும். 

 

7 எலிப்ஸ் டூல் ேற்றும் எலிப்ஸ் ஃபிமரம் டூல் மவறுபடுத்துக. 

 எலிப்ஸ் டூல் எலிப்ஸ் ஃபிமரம் டூல் 

வட்ைம் ேற்றும் நீள்வட்ைம் வலரயப் 

பயன்படுகிறது. 

உலர ேற்றும் வலரகலைகலள 

லவப்பேற்கான நீள்வட்ைங்கலள 

வலரயப் பயன்படுகிறது. 
 

10 தோைர்புள்ள உலரத்தோகுதி என்றால் என்ன?  

 ➢ ஒரு உலரத்தோகுதியிலுள்ள உலரயானது ேற்தறாரு 

உலரத்தோகுதிக்குள் தசல்லுோறு, ஒரு உலரத்தோகுதிலய ேற்தறாரு 

உலரத்தோகுதியுைன் இலணக்கமவா அல்ைது தோைர்புபடுத்ேமவா முடியும்.  

➢ இவ்வாறு தோைர்புபடுத்ேப்பட்டிருக்கும் உலரத்தோகுதிகளுக்கு 

தோைர்புள்ள உலரத்தோகுதிகள் என்று தபயர். 

 

11 தோைர்புள்ள உலர என்றால் என்ன?  

 ➢ உலரத்தோகுதிகளுக்கு இலைமய உள்ள உலரலய இலணக்கும் 

தசயல்முலறக்கு தோைர்புள்ள உலர என்று தபயர். 

 

பகுதி – இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

1 மபஜ்மேக்கர் என்றால் என்ன? அேன் பயன்கலள கூறு.  

 அமைாப் மபஜ்மேக்கர்: 

➢ அமைாப் மபஜ்மேக்கர் என்பது ஒரு பக்க வடிவலேப்பு தேன்தபாருளாகும்.  

பயன்கள் 

➢ அச்சிடுவேற்கு ஏற்ற வலகயில் ஆவணங்கலள வடிவலேக்கப் 

பயன்படுகிறது. 

➢ சிறிய வணிக அட்லை முேல் தபரிய புத்ேகம் வலர அலனத்லேயும் 

வலவலேக்கைாம் 

➢ எளிோக உலர ேற்றும் வலரகலை வடிவங்கலள மசர்க்க உேவுகின்றன. 

 

2 மபஜ்மேக்கரில் உள்ள ஏமேனும் மூன்று கருவிகலளயும் அேன் விலசப்பைலக 

குறுக்கு வழிகலளயும் கூறு. 

 கருவி விலசப்பைலக 

குறுக்கு வழி 

தராட்மைடிங் டூல் Shift+F2 

லைன் டூல் Shift+F3 

தரக்ைாங்கில் டூல் Shift+F4 
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3 மபஜ்மேக்கரில் உள்ள ஏமேனும் மூன்று கருவிகளின் குறும்பைங்கலளயும், அேன் 

பயன்கலளயும் கூறு. 

 கருவி குறும்பைம் பயன்கள் 

தராட்மைடிங் டூல் 

 

தபாருள்கலள மேர்ந்தேடுக்க ேற்றும் 

சுைற்ற 

லைன் டூல் 

 

மநர்மகாடு வலரய  

தரக்ைாங்கல் டூல் 

 

சதுரம் ேற்றும் தசவ்வகம் வலரய 

எலிப்ஸ் டூல்  

 

வட்ைம் ேற்றும் நீள்வட்ைம் வலரய  
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உலர உள்ள சட்ைங்கலள எவ்வாறு இலணப்பாய்?  

 ➢ இரண்ைாவது சட்ைம் வலரய மவண்டும்.  

➢ முேல் சட்ைத்லே கிளிக் தசய்து மேர்ந்தேடுக்க மவண்டும்.  

➢ கீழ்ப்பக்க லகப்பிடியிலுள்ள உள்ள சிவப்பு முக்மகாணத்லேக் கிளிக் தசய்ய 

மவண்டும்.  

➢ பின்னர் இரண்ைாவது சட்ைத்லேக் கிளிக் தசய்ய மவண்டும். உலர 

இரண்ைாவது சட்ைத்தில் விரியும். 

 

6 ோஸ்ைர் பக்கத்தின் பயன் என்ன? 

 ➢ ோஸ்ைர் பக்கத்தில் லவக்கப்படும் எந்ேதவாரு தபாருளும் ஆவணத்தில் 

உள்ள அலனத்துப் பக்கங்களிலும் மோன்றும். 

➢ ோஸ்ைர் பக்கங்கள் தபாதுவாக மைாமகாக்கள் (logos), பக்க எண்கள், 

ேலைப்புகள் ேற்றும் அடிக்குறிப்புகள் தகாண்டிருக்கின்றன. 

 

7 ோஸ்ைர் பக்கத்தில் பக்க எண்கலள எவ்வாறு மசர்ப்பாய்? 

 ➢ Master pages பணிக்குறியில் கிளிக் தசய்ய மவண்டும். 

➢ தைக்ஸ்ட் டூலைக் கிளிக் தசய்ய மவண்டும். 

➢ இைது ோஸ்ைர் பக்கத்லேக் கிளிக் தசய்ய மவண்டும்.  

➢ Ctrl+Alt+P என்பலே அழுத்ே மவண்டும்.  

➢ இைது ோஸ்ைர் பக்கத்தில் பக்க எண் ‘LM’ எனத் மோன்றும்.  

➢ வைது ோஸ்ைர் பக்கத்லேக் கிளிக் தசய்ய மவண்டும். 

➢ Ctrl+Alt+P என்பலே அழுத்ே மவண்டும் 

➢ வைது ோஸ்ைர் பக்கத்தில் பக்க எண் ‘RM’ எனத் மோன்றும். 

➢ ேற்ற பக்கங்களில் சரியான பக்க எண்கள் தேரியும். 

 

பகுதி – ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 

  

1 மபஜ்மேக்கர் கருவிப்தபட்டியிலுள்ள கருவிகலளப் பற்றி விவரி. 
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 கருவியின் தபயர் பயன் 

பாயின்ைர் டூல் உலர ேற்றும் வலரகலைப் பைங்கலளத் 

மேர்ந்தேடுக்க, நகர்த்ே, அளலவ ோற்ற 

தைக்ஸ்ட் டூல் உலரலய உள்ளிை, மேர்ந்தேடுக்க, பதிப்பிக்க 

தராட்மைடிங் டூல் தபாருள்கலள மேர்ந்தேடுக்க ேற்றும் சுைற்ற 

கிராப்பிங் டூல் வலரகலைகலள ஒழுங்கலேக்க 

லைன் டூல்  மநர்மகாடு வலரய  

கன்ஸ்தரய்ன்டுன் டூல்  கிலைேட்ைோகவும், தசங்குத்ோகவும் 

மகாடுகள் வலரய  

தரக்ைாங்கல் டூல்  சதுரம் ேற்றும் தசவ்வகம் வலரய  

தரக்ைாங்கல் ஃபிமரம் டூல்  உலர ேற்றும் வலரகலைகலள 

லவப்பேற்கான தசவ்வகங்கலள வலரய  

எலிப்ஸ் டூல்  வட்ைம் ேற்றும் நீள்வட்ைம் வலரய  

எலிப்ஸ் ஃபிமரம் டூல்  உலர ேற்றும் வலரகலைகலள 

லவப்பேற்கான நீள்வட்ைங்கலள வலரய  

பாலிகான் டூல்  பைமகாணங்கள் வலரய  

பாலிகான் ஃபிமரம் டூல்  உலர ேற்றும் வலரகலைகலள 

லவப்பேற்கான பை மகாணங்கலள வலரய  

மேண்ட் டூல்  பக்கத்லே திலர உருளல் தசய்ய  

ஜும் டூல்  பக்கத்தின் அளலவ தபரிோக்கியும், 

சிறிோக்கியும் பார்க்க. 
 

 

2 

 

சட்ைத்தில் உலரலயலவப்பேற்கான வழிமுலறகலளக் கூறு.  

 ➢ கருவிப்தபட்டியில் உள்ள தசவ்வகம் அல்ைது நீள்வட்ைம் அல்ைது 

பைமகாணம் ஃபிமரம் டூல்களில் ஏமேனும் ஒன்றின் மீது கிளிக் தசய்ய 

மவண்டும். 

➢ அலேப் பயன்படுத்தி ஒரு சட்ைம் வலரய மவண்டும்.  

➢ பட்டிப்பட்லையில் File -> Place என்பலே மேர்வு தசய்ய மவண்டும்.  

➢ Place உலரயாைல் தபட்டி மோன்றும்.  

➢ தசருக மவண்டிய உலர உள்ள ஆவணத்லே மேர்வு தசய்ய மவண்டும்.  

➢ Open தபாத்ோலனக் கிளிக் தசய்ய மவண்டும்.  

➢ உலரலய தசருக மவண்டிய சட்ைத்தில் கிளிக் தசய்ய மவண்டும். 

உலரயானது சட்ைத்தில் தசருகப்பட்டுவிடுே 

 
3 உலரத்தோகுதியிலுள்ள உலரலய சட்ைத்திற்கு எவ்வாறு ோற்றுவாய்?  
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 ➢ மபஜ்மேக்கரில் உள்ள ஃபிமரம் டூல்களில் ஏமேனும் ஒன்லறப் பயன்படுத்தி 

சட்ைம் ஒன்லற வலரய மவண்டும்.  

➢ சட்ைத்திற்குள் தசருக மவண்டிய உலரத்தோகுதிலயத் மேர்ந்தேடுக்க 

மவண்டும்.  

➢ Shift விலசலய அழுத்திக் தகாண்டு சட்ைத்லேக் கிளிக் தசய்ய மவண்டும். 

➢ இப்தபாழுது இரண்டு தபாருள்களும் மேர்ந்தேடுக்கப்பட்டிருக்கும். 

➢ பட்டிப் பட்லையில் Element > Frame > Attach Content என்பலேக் கிளிக் 

தசய்ய மவண்டும்.  

➢ இப்தபாழுது உலரயானது சட்ைத்திற்குள் மோன்றும். 

 

உள்ளீடு                              தவளியீடு 
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பாடம் – 2 

அடடாப் இன்டிசைன் 

பகுதி – அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 ஒன்று அல்ைது அேற்கு மேற்பட்ை சட்ைங்கலள ஆக்கிரமித்திடுக்கும் 

தோைர்ச்சியான உலர அ) கலே (story) 

2 In Design –னுள்ள ஒவ்தவாரு உலரயின் துண்டுப் பகுதியும் அ) உலரச் சட்ைம் ( text 

frame ) 

3 ஆவணத்லே ச் சுற்றியுள்ள பகுதி அ) ஒட்டுப்பைலக ( paste board ) 

4 ஒன்லற ஒன்று பார்க்கும் வலகயில் அலேந்துள்ள இரணடு ஆவணப் 

பக்கங்களின் தோகுதி அ) பரவல் (spread) 

5 …………………என்பது Indesign னுள்ள அலனத்து கருவிகலளயும் தகாண்டுள்ள 

தபட்டியாகும் அ)கருவி பைகம் 

6 பக்கத்தின் இரண்டு தநடுவரிலசகளுக்கு இலைப்பட்ை பகுதி அ) Gutter 

7 ஒரு பக்கத்தில் இைம்தபரும் உலரப்பகுதி அல்ைது உறுப்பு அ) வலரகலை 

(Graphics) 

8 ………….. என்று Adobe Photoshop மபான்ற நிரல் மூைம் உருவாக்கப்படும் 

பைப்புள்ளிகலளக் (pixels) தகாண்ை நிைற்பைங்கள் அ) பிட்மேப் 

9 இரண்டு அல்ைது மூன்று வண்ணங்கள் படிப்படியாக இலணத்து கைலவ அ) 

Gradient 

10 நிறுவனங்களால் ேயாரிக்க ப்படும் தசயைற்ற அ) Spot நிறங்கள் 

11 ஒரு தபாருளின் உள்மள இைப்படும் வண்ணம் அ) நிரப்பு (fill) 

12 தபாருளின் தவளிப்புறக் மகாட்டில் இைப்படும் வண்ணம் அ) எல்லை (stroke) 

பகுதி – ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 Adobe in Design என்ன தேன்தபாருள்? 

 ➢ Adobe InDesign CC 2019 என்பது ‘Adobe Creative Clud’ குடும்பத்தின் 

தேன்தபாருள் நிரலின் ஒரு பகுதியாகும்.  

➢ InDesign என்பது பக்க வடிவலேப்பு (page layout) தேன்தபாருள் நிரைாகும்.  

➢ ஆவணங்கலள வடிவலேக்கவும் ேற்றும் ேயாரிக்கவும் உேவுகின்றது.  

➢ இவ்வலக ஆவணங்கலள அச்சிை முடியும் அல்ைது வலையகத்தில் 

பயன்படுத்ே முடியும் 

 

2 எத்ேலன வலகயான தகாைநிலை பக்க அலேவுகள் உள்ளன? அலவ எலவ? 

 இரண்டு வலகயான தகாைநிலை பக்க அலேவுகள் உள்ளன 

➢ Landscape 

➢ Portrait  
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3 Adobe in Design ல் பணிப்பகுதி என்றால் என்ன? 

 ➢ InDesign சன்னல் திலரயில் மோன்றும் சன்னல்கள் ேற்றும் பைகங்கள் 

ஆகியவற்றின் அலேப்மப பணித்ேளம் எனப்படும்.  

 

4 In Design ஆவண சன்னல் திலரயில் எது அவசியோனது? 

 ➢ InDesignஐ தோைங்கும் மபாது ோனலேவாக இைம் தபறும் பணித்ேளம் 

“Essentials” எனப்படும்.  

➢ இது மேமை கட்டுப்பாட்டுப் பைகம், இைப்புறம் கருவிப்பைகம் 

ஆகியவற்றுைன் InDesign சன்னல் திலரயில் மோன்றும்.  

➢ திலரயில் மோன்றும் சன்னல்கள் ேற்றும் பைகங்கள் ஆகியவற்றின் 

அலேப்மப பணித்ேளம் எனப்படும்.  

➢ InDesign பணித்ேளம் பின்வரும் பகுதிகலள சிறப்பம்சோகக் தகாண்டுள்ளது.  

• ஆவண சன்னல் (Document Window) 

• ஒட்டு பைலக (Paste Board) 

• கட்டுப்பாட்டுப் பைகம் (Control Panel), 

• கருவிப் பைகம் (Tools panel). 

 

5 In Design -ல் pasteboard என்பது என்ன? 

 ➢ ஒட்டுப்பைலக என்பது ஆவணச் சன்னலைச் சுற்றியுள்ள சாம்பல் 

நிறப்பகுதி ஆகும்.  

 

6 Tool tip எப்தபாது மோன்றும்? 

 ➢ கருவிப்பைகத்தில் கிளிக் தசய்யாேல் ஏமேனும் ஒரு கருவியின் மீது 

தசருகும் புள்ளிலய லவக்கும் தபாழுது tool tip மோன்றும். கருவியின் தபயர் 

ேற்றும் குறுக்கு வழி சாவி அலைப்புக்குறிக்குள் மோன்றும் 

 

7 Page tool –ன் பயன் என்ன? 

 ➢ Page கருவியானது ஒரு ஆவணத்திற்குள் பல்மவறு பக்க அளவுகள் 

உருவாக்க உேவுகின்றது.  

➢ Shift + P லய பக்க கருவிலயத் மேர்ந்தேடுக்க கிளிக் தசய்யவும். இப்தபாழுது 

கட்டுப்பாட்டுப் பக்கத்தில் (Control Page) உள்ள மேர்லவப் பயன்படுத்தி பக்க 

அலேலவ ோற்றைாம் 

பகுதி - இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

2 கருவி பைகத்தில் (Tools panel) உள்ள ஏமேனும் 3 கருவிகலள பற்றி எழுதுக. 

 ➢ மேர்ந்தேடுப்புக் கருவி : இது தபாருள்கலள அல்ைது தபாருள்களின் 

தோகுதிலய மேர்ந்தேடுக்கப் பயன்படுகிறது. V என்ற தபாத்ோலன அழுத்தி 

இந்ேக் கருவிலய மேர்ந்தேடுக்கைாம்.  

➢ மநரடி மேர்வு கருவி (Direct Selection tool) : இது ஒரு குழுவில் இருந்து ஒமர 

ஒரு தபாருலள மேர்ந்தேடுக்க (A லவ அழுத்ேவும்) உேவுகிறது. 
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➢ பக்கக்கருவி (page Tool) : ஒரு ஆவணத்தின் உள்மள பல்மவறு பக்க 

அளவுகலள உருவாக்க பக்கக்கருவி பயன்படுகிறது. 

 

6 ஒரு தபாருலள எப்படி உருவாக்குவாய் என விரிவாக விவரி. 

 ➢ பதிப்பிற்கு மேலவப்படும் ஒமர வலக தபாருள் எளிய வடிவங்களாகும்.  

➢ வடிவங்கலள உருவாக்கும் கருவிகள் Rectangle, Ellipse ேற்றும் polygon 

மபான்ற கருவிகலளக் தகாண்டுள்ளது.  

➢ ஒரு வடிவ கருவிலயத் மேர்ந்தேடுக்க, கருவிகள் பைகத்தில் Rectangle 

கருவி மீது கிளிக் தசய்து சுட்தைலி தபாத்ோலன அழுத்தி பிடித்ேவாமற, 

நாம் பயன்படுத்ே விரும்பும் வடிவ கருவிலயத் மேர்ந்தேடுக்கைாம்.  

➢ வடிவ கருவி மேர்ந்தேடுக்கப்பட்ை பின், ஆவணத்தில் அலே இழுப்பேன் 

மூைம் லகமுலறயாக (manually) வடிவத்லே உருவாக்கைாம்.  

 

7 கருவி பைகத்திலுள்ள வலரபை சட்ைங்கள் எத்ேலன ? அலவ யாலவ? 

 கருவி பயன்கள் 

Ellipse சட்ைகம் இந்ே கருவிலயப் பயன்படுத்தி 

நீள்வட்ை (oval) ேற்றும் வட்ை (round) 

-சட்ைகங்கலள உருவாக்கைாம். 

Rectangle சட்ைகம் இந்ே கருவிலயப் பயன்படுத்தி 

தசவ்வக ேற்றும் சதுர சட்ைகங்கலள 

உருவாக்கைாம். 

Polygon சட்ைகம் இந்ே கருவிலயப் பயன்படுத்தி 

சேபக்க பைமகாண (equilateral polygon) 

சட்ைகங்கலள உருவாக்கைாம். 
 

பகுதி - ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 

  

1 InDesign-ல் புதிய ஆவனத்லே உருவாக்குவேற்கான படிநிலைகலள எழுதுக 

 ➢ Start -> All programs -> Adobe Indesign CC 2019 என்பலே மேர்வு தசய்யவும் 

(அல்ைது) திலரமுகப்பில் உள்ள InDesign குறுக்கு வழிலயத் மேர்வு 

தசய்யவும். 

➢ “Welcome to InDesign” என்ற சன்னல் திலர திறக்கப்படும்.  

➢ இப்தபாழுது Create New தபாத்ோலனக் கிளிக் தசய்யவும். 

➢ இப்தபாழுது New Document window புதிய ஆவண சன்னல் திறக்கப்படும். 

➢ New Document உலரயாைல் தபட்டியில் Category ேத்ேலில் உள்ள print, web 

அல்ைது Mobile ஐ மேர்வு தசய்யவும். 

➢ பின்வரும் மேர்வுகலள ஏற்கனமவ மேர்வுதசய்யப்பட்ை தோகுதியில் 

குறிப்பிைவும்.  

• Width and Height: ஆவணத்தின் அளலவ குறிப்பிடுகிறது.  

• Units: ஆவணத்லே அளவிடுவேற்கான அைலகக் குறிப்பிடுகிறது.  

• Orientation : ஆவணத்திற்கான பக்க வடிவலேப்லப (Landscape or Portrait) 

குறிப்பிடுகிறது.  
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• Pages : ஆவணத்தில் உருவாக்கப்படும் பக்கங்களின் எண்ணிக்லகலய 

குறிப்பிடுகிறது.  

• Facing Pages: ஒரு பக்கத்லே ேட்டுமே உலைய ஆவணத்லே 

உருவாக்குவேற்கு Facing Pagesஐ Turn off தசய்ய மவண்டும். புத்ேகங்கள் 

ேற்றும் இேழ்கள் ஆகியவற்றுக்கு Facing Pages ஐ Turn on தசய்ய 

மவண்டும்.  

• Start #: எந்ே எண்ணில் ஆவணம் தோைங்குகிறது என்பலேக் 

குறிப்பிடுகிறது.  

• Primary Text Frame: முேன்லே பக்கத்தில் (Master Page) முக்கிய 

உலரலயச் மசர்க்க (Primary text) இந்ேத் மேர்லவ மேர்ந்தேடுக்கவும்.  

• Columns: ஆவணத்தில் மசர்க்கப்பை மவண்டிய தநடுவரிலசகளின் 

(Column) எண்ணிக்லகலயக் குறிப்பிை பயன்படுகிறது 

• Column Gutter: தநடுவரிலசகளுக்கு இலைமய உள்ள இலைதவளியின் 

அளலவக் குறிப்பிை உேவுகிறது.  

• Margins: ஆவணத்தின் ஒவ்தவாரு பக்கத்திற்கும் ஒரு அளலவ குறிப்பிை 

பயன்படுகிறது.  

• Bleed and Slug: ஆவணத்தின் ஒவ்தவாரு பக்கத்தினுைமன Bleed and Sug 

இருப்பிைத்லே குறிப்பிடுகிறது.  

➢ முன்மப இருத்ேப்பட்ை அலேப்புகமளாடு ஆவணத்லேத் திறக்க Create 

தபாத்ோன்கலளக் கிளிக் தசய்யவும். 

 

2 சிறு குறிப்பு எழுதுக பயன்பாட்டு பட்லை (Application bar) ஆவண  தோகுதி (Documen 

Tab) கருவி பைகம் (Tools pannel) 

 பயன்பாட்டு பட்லை (Application bar)  

➢ இது பணித்ேளத்திற்கு மேல் உள்ளது.  

➢ இதில் பை பட்டிகள் (menu) உள்ளன.  

➢ ஒரு பட்டிலயத் திறக்க, பயன்பாட்டு பட்லையில் உள்ள பட்டியின் 

தபயலரக் கிளிக் தசய்யவும்.  

➢ ஒவ்தவாரு பட்டியும் பட்டிவலகமயாடு தோைர்புலைய கட்ைலளகலளப் 

பட்டியலிடும். 

➢ பட்டிப்தபயர்களின் வைதுப்புறத்தில் பணித்ேளமும் ேற்றும் View மேர்வுகளும் 

உள்ளன. 

ஆவணத் ேத்ேல் (Document tab)  

➢ ஆவணத் ேத்ேல், கிலைேட்ை ரூைர்க்கு மேல்பகுதியில் உள்ளது.  

➢ இது ஆவணத்தின் தபயர், உருப்தபருக்கத்தின் நிலை (Magnification) ேற்றும் 

மூடு தபாத்ோன் ஆகியவற்லறக் தகாண்டுள்ளது.  

➢ ஒன்றிற்கு மேற்பட்ை ஆவணங்கள் திறந்திருந்ோல், ஒவ்தவாரு 

ஆவணத்திற்கும் ஒரு ேத்ேல் மோன்றும். 

➢ ஆவணத் ேத்ேல்கள் கிலைேட்ை வரிலசயில் மோன்றும்.  

➢ ஆவணத் ேத்ேலை கிளிக் தசய்து, அந்ே ஆவணத்லேச் சன்னல்திலரயில் 

காணைாம்.  

➢ முழுலேயான சன்னல்திலரயில் ஆவணத்லேத் திறக்க, ஆவணத் 

ேத்ேலை கிளிக் தசய்து இழுத்து குழுலவ விட்டு தவளிமயற்ற மவண்டும்.  

கருவிகள் பைகம் (Tools Panel)  
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➢ InDesign-ல் இருக்கும் அலனத்து கருவிகளும் இந்ே கருவிகள் பைகத்தில் 

இருக்கின்றன.  

➢ தபாருலள உருவாக்கும் கருவிகள், தபாருலள உருோற்றும்  கருவிகள், 

பக்க காட்சிலய ோற்றுேல் ேற்றும் பணித்ேளத்திற்கு தசல்லுேல் கருவிகள் 

ஆகிய கருவிகள் உள்ளன. 

➢ சிை கருவிகளின் கீழ் வைது மூலையில் இருக்கும் ஒரு சிறிய 

முக்மகாணத்லே கிளிக் தசய்து அழுத்தி பிடிப்பேன் மூைம் ேலறந்திருக்கும் 

கூடுேைான கருவிகலளக் காணைாம். 

 

4 வலரகலை சட்ைத்தில் எவ்வாறு பைத்லே மசர்ப்பாய் படிநிலைகலள எழுதுக 

 ➢ வலரகலை சட்ைகம் பிற தேன்தபாருள் நிரலில் உள்ள பைங்கலளத் 

ேருவிக்கபயன்படுகிறது.  

➢ சட்ைகத்தில் பைங்கலளச் தசருகைாம். 

• வலரகலை சட்ைகத்லே உருவாக்க மவண்டும். 

• File -> Place என்பலேத் மேர்ந்தேடுக்கவும்.  

• Place உலரயாைல் தபட்டி மோன்றும்.  

• சட்ைகத்தில் தசருக விரும்பும் பைத்லேக் கண்டுபிடித்து 

மேர்ந்தேடுக்கவும்.  

• Open மீது கிளிக் தசய்யவும். 
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பாடம் – 3 

அடடாப் இன்டிசைன் 

பகுதி – அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 _________ என்பது ஒரு தவக்ைர் வலரகலை பயன்பாைாகும்.  

இ) Corel Draw  

2 தவக்ைார் வலரகலையானது _________ தகாண்டு உருவாக்கப்படுகின்ற. அ) 

மகாடுகள் ேற்றும் வலளவுகள்  

3 _________ என்பலவ தசவ்வகப்பைம் (raster image) என அலைக்கப்படுகின்றன.  

ஆ) பிட்மேப்ஸ்  

4 _________ லன பயன்படுத்தி நீங்கள் தவக்ைார் வலரகலையிலன உருவாக்க 

முடியும். இ) Corel Draw  

5 தசந்ேர கருவிப்பட்லைக்கு (Stadard toolbar) அடுத்திருப்பது _________. 

அ) பண்பு பட்லை  

6 எந்ே கருவி ஒரு தபாருளிலன மேர்வு தசய்ய உேவுகின்றது?  

இ) Pick கருவி 

7 வட்ைத்லே வலரய அந்ே கருவி உேவுகின்றது. ஆ) Ellipse கருவி  

8 எத்ேலன வலக சுருள்கள் உள்ளன?  இ) 2  

9 _________ சாவியானது Freehand கருவியிலன மேர்வு தசய்ய உேவுகின்றது.   

ஈ) F5 

10 Corel Drawவில் ஒரு ஆவணத்லே மூை _________ லன அழுத்ே மவண்டும். 

அ) Ctrl + F4  

11 _________ சாவி ஒரு தபாருலள மேர்வு தசய்ேலே நீக்க உேவுகின்றது.  

அ) ESC  

12 _________ சாவி சர்ோனம் மேர்வு தசய்யப்பட்ைை தபாருளின் பிரதியிலன 

உருவாக்க உேவுகின்றது. அ) Ctrl +D  

13 இலணக்கப்பட்ை தபாருளிலன ேனித்ேனிமய பிரிக்க _________ லன 

அழுத்ேவும். அ) Ctrl + K  

14 இரண்டு அல்ைது அேற்கு மேற்பட்ை தபாருட்கலள இலணக்க _______ லன 

அழுத்ேவும். ஆ) Ctrl + L 

  

பகுதி – ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 Corel Draw எேற்காக பயன்படுத்ேப்படுகின்றது? 

 ➢ CorelDraw என்பது உயர்ேர வலரகலை சித்திரங்கள், மைாமகா வடிவலேப்பு 

ேற்றும் பக்க அலேப்புகலள உருவாக்குவேற்கான பல்துலற வலரகலை 

பயன்பாடு ஆகும். 

 

2 Corel Drawவில் ஒரு புதிய ஆவணத்லே உருவாக்க படிநிலைகலள எழுதுக. 
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 ➢ வரமவற்பு திலரயில் New Document தபாத்ோலன கிளிக் தசய்யவும்.  

➢ இப்மபாது Create a New Document உலரயாைல் தபட்டி மோன்றும்.  

➢ நீங்கள் அதில் ஆவணத்திற்கு தபயரிைவும், பக்க அளவு அலேக்கவும், 

CMYK அல்ைது RGB மபான்ற நிற முலறலேலயத் மேர்வு தசய்யவும், 

வண்ண விவரங்கலளயும் அலேக்கைாம்.  

➢ OK தபாத்ோலனகிளிக் தசய்யவும் 

 

3 Corel Drawவில் ைாக்கர் (Docker) என்றால் என்ன? 

 ➢ Docker என்பது ஒரு குறிப்பிட்ை கருவி அல்ைது பணிக்கு தோைர்புலைய 

கட்ைலளகள் ேற்றும் அலேப்புகலளக் தகாண்டிருக்கும் ஒரு சாளரம் 

ஆகும். 

 

4 Corel Draw விலன தோைங்குவேற்கு என படிநிலைகலள எழுதுக. 

 ➢ CorelDRAW 2018 மநரடியாக கணினியின் திலரமுகப்பில் (Desktop) 

இருந்மோ அல்ைது Windows தோைக்க பட்டியில் (Start Menu) இருந்மோ 

தோைங்கைாம்.  

➢ Start > All Programs >CorelDRAW Graphics Suite 2018 >CorelDRAW 2018 

என்பலே மேர்ந்தேடு  

➢ அல்ைது, திலரமுகப்பில் CorelDRAW 2018 சின்னத்தின் மீது சுட்டிலய 

லவத்து, இரட்லை கிளிக் தசய்து CorelDRAW 2018 ஐ திறக்கைாம்  

➢ CorelDRAW 2018 - வரமவற்புத் திலர மோன்றும். 

 

5 Corel Draw வில் ஒரு தபாருள் என்றால் என்ன? 

 ➢ கருவிகலள தகாண்டு நாம் உருவாக்கப்படும் வலரபைங்கள் தபாருட்கள் 

எனப்படும். 

➢ தபாருள் என்பது பைம், வடிவம், மகாடு, உலர, வலளவு, சின்னம், அல்ைது 

அடுக்கு மபான்ற வலரபைத்தின் ஒரு உறுப்பு. 

 

6 Corel Draw வில் பண்பு பட்லை (Property Bar) என்றால் என்ன? 

 ➢ பண்புப் பட்லை (Property bar) தசந்ேரகருவிப்பட்டிக்கு அடுத்து இருக்கும்.  

➢ இயக்க கருவிக்கு தோைர்புலைய தபாதுவான தசயல்பாடுகலள இது 

காட்டுகிறது. இது கருவிப்பட்டிலயப் மபாை மோன்றினாலும், கருவி 

அல்ைது பணிலயப் தபாருத்து பண்புகள் பட்லையின் உள்ளைக்கம் 

ோறுகிறது.  

➢ கருவிப்தபட்டியில் நீங்கள் தசவ்வக கருவிலயக் கிளிக் தசய்ோல், பண்பு 

பட்லை தசவ்வகம் தோைர்பான கட்ைலளகலள ேட்டுமே காட்டும் 

 

7 Corel Draw வில் ரூைர் (Ruler) ஏன் பயன்படுத்ேப்படுகின்றது. 

 ➢ சாளரத்தில் இரண்டு ரூைர் இருக்கும். அலவ கிலைேட்ை ரூைர் ேற்றும் 

தசங்குத்து ரூைர்.  

➢ ரூைர் ஒரு ஆவணத்தில் தபாருட்களின் அளவு ேற்றும் நிலைலய 

தீர்ோனிக்கப் பயன்படுத்ேப்படுகின்றன. 
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8 Corel Draw வில் கலைத்திறனுள்ள ஊைக கருவி (Artistic Media tool) ஏன் 

பயன்படுத்ேப்படுகின்றது? 

 ➢ கலை தூரிலக, தேளிப்பு ேற்றும் calligraphic விலளவுகலள மசர்ப்பைேற்கு 

பயன்படுகின்றது. 

 

9 தபாருட்கலள குழுவாக்க படிநிலைகலள எழுதுக. 

 ➢ Pick கருவி தகாண்டு தபாருள்கலள மேர்வு தசய்யவும். (பை தபாருள்கலள 

மேர்வு தசய்ய Shift சாவியிலன அழுத்தியவாறு மேர்வு தசய்யவும். 

➢ Object -> Group -> Group objects என்பலே மேர்வு தசய்யவும் (அல்ைது) Ctrl 

+ G லன அழுத்ேவும்.  

➢ மேர்வு தசய்யப்பட்ை தபாருட்கள் ஒமர தபாருளாக குழுவாக்கப்படும். 

 

10 குழுவாக்கப்பட்ை தபாருளின் குழுவாக்கத்லே நீக்கபடிநிலைகலள எழுதுக. 

 ➢ Pick கருவி தகாண்டு குழுவாக்கப்பட்ை தபாருலள மேர்வு தசய்யவும். 

➢ பட்டி பட்லையிலிருந்து Object -> Group -> Ungroup Objects என்பலே மேர்வு 

தசய்யவும் (அல்ைது) விலசப்பைலகயிலுள்ள Ctrl + U என்பலே அழுத்ேவும் 

அல்ைது Property பட்லையிலுள்ள Ungroup objects என்பலே கிளிக் 

தசய்யவும்.  

➢ குழுவாக்கப்பட்ை தபாருளானது அேனுலைய தபாருட்களின் கூறுகளாக 

பிரியும் 

 

பகுதி - இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

1 தவக்ைார் வலரகலைக்கும் பிட்மேப்ஸ் (Bitmaps) க்கும் இலைமய உள்ள 

மவறுபாடுகள் யாலவ? 

 ➢ தவக்ைர் வலரகலையானது (Vector graphics) மகாடுகள் ேற்றும் வலளவுகள் 

தகாண்டு உருவாக்கப்படுகின்றது. இலவகள் கணிேத்திற்குரிய 

விளக்கங்கலள தகாண்டு உருவாக்கப்படுகின்றன. இவ்வலகயான 

வலரகலையானது சின்னங்கள் ேற்றும் விளக்கப்பைங்கள் (Logos and 

illustrations) ஆகியவற்றிற்கு ஏற்றலவ ஆகும். 

➢ பிட்மேப்ஸ் (Bitmaps) என்பது தசவ்வகப்பைம் (Raster images) என 

அலைக்கப்படுகின்றது. இது பை புள்ளிகள் (Pixels) என அலைக்கப்படும் சிறிய 

சதுரங்கலள தகாண்டு உருவாக்கப்படுகின்றது. 

 

4 இரண்டு வலகயான சுருள்கள் என்பலவ என்ன? விளக்குக. 

 ➢ இரண்டு வலகயான சுருள்கள் உள்ளன. அலவ 1. சேச்சீர் சுருள் 

(Symmetrical Spiral) 2. ேைக்லக சுருள் (Logarithmic spiral). 

➢ சேச்சீர் சுருளானது (Symmetrical Spiral). சேோக விரிவலைகின்றது. 

ஆேனால் ஒவ்தவாரு சுைற்சிக்கும் இலைமயயான தூரமும் சேோக 

இருக்கும்.  
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➢ ேைக்லக சுருளானது (Logarithmic Spiral) சுைற்சிகளுக்கிலைமய அதிகரிக்கும் 

அதிக தூரத்துைன் விரிவலைகின்றது. 

 

6 Corel Draw வில் பிலைகலள சரி தசய்ய என்ன தசய்ய மவண்டும்? அேலன 

தசய்வேற்கான விலசப்பைலக குறுக்கு வழி என்ன?5 

 ➢ நைப்பு அேர்வில்  முன்னர் தசய்ே தசயல்பாடுகலள Corel Draw நிலனவில் 

தகாண்டிருக்கும்.  

➢ மிக சமீபத்தில் தசய்ே தசயலில் ஆரம்பித்து, வலரயும்தபாழுது தசய்ே 

தசயல்கலள எல்ைாம் Undo தசய்ய முடியும்.  

➢ ஒரு தசயலை Undo (தசய்ேலே நீக்கு) தசய்வதினால் வரும் விலளவுகள் 

உங்களுக்கு பிடிக்கவில்லை எனில் நீங்கள் அேலன Redo (ேறுபடியும் 

தசய்) தசய்து தகாள்ளைாம். 

➢ ஒரு தசயலை Undo தசய்ய Edit -> Undo மேர்வு தசய்யவும் (கலைசி தசயல்)  

➢ ஒரு தசயலை Redo தசய்ய Edit -> Redo மேர்வு தசய்யவும் 

➢ வலரபைத்தின் கலைசியாக மசமிக்கப்பட்ை நிலைக்கு பின்தசல்ை File -> 

Revert மேர்வு தசய்யவும். 

➢  ஒரு தசயலை மீண்டும் மீண்டும் தசய்ய Edit -> Repeat மேர்வு தசய்யவும். 

 

7 ஒரு மகாட்டிலன அம்புகுறியாக ோற்றுவேற்கு நீங்கள் என்ன தசய்வீர்கள்? 

 மகாட்டில் அம்புக்குறி மசர்க்க  

➢ Freehand கருவி மூைம் ஒரு மகாடு வலரயவும்.  

➢ மகாட்லை மேர்ந்தேடுக்கவும்.  

➢ பண்புபட்லையில் உள்ள End Arrow head Selector கீமை இறங்கு 

பட்டிதபட்டியில் கிளிக் தசய்யவும்.  

➢ பின் மேலவயான அம்புக்குறி முலனலய மேர்வு தசய்யவும்.  

➢ இப்மபாது மகாடு அம்புக்குறியுைன் மோன்றும். 

 

10 தபாருள்கலள தவல்டிங் தசய்வேன் மூைம் என்ன தபற முடியும்? தபாருள்கலள 

தவல்டிங் தசய்வேற்கான படிநிலைகலள எழுதுக 

 ➢ தவல்டிங் தசய்வேன் மூைம் ஒழுங்கற்ற வடிவங்கலள நீங்கள் உருவாக்க 

முடியும்.  

➢ தபாருள்கலள தவல்டிங் தசய்ய 

➢ Pick கருவி தகாண்டு (அல்ைது) Shift சாவியிலன அழுத்தியவாறு 

தபாருள்கலள மேர்வு தசய்யவும்.  

➢ Object - > Shaping -> Weld என்ற கட்ைலளயிலன பட்டி பட்லையிலிருந்து 

மேர்வு தசய்யவும் (அல்ைது) Property பட்லையிலுள்ள Weld தபாத்ோலன 

கிளிக் தசய்யவும்.  

➢ தபாருள்கள் தவல்டிங் தசய்யப்பட்டு, ஒமர எல்லைமகாடு தகாண்ை 

தபாருளாக ோறும். 

பகுதி - ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 
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1 சுருளிலன (Spiral) வலரய படிநிலைகலள எழுதுக. 

 ➢ பைமகாண கருவியின் மீது அழுத்திப் பிடித்ேவாமர இருந்ோல் flyout பட்டி 

மோன்றும். 

➢ flyout பட்டியில் உள்ள சுருள் (Sprial) கருவிலய கிளிக் தசய்யவும்.  

➢ பண்பு பட்லையில் உள்ள சுருள் சுைற்சி தபட்டியில் சுருள்களின் 

எண்ணிக்லகலய தகாடுக்கவும். 

➢ பின் பண்பு பட்லையில் கீழ்கண்ை ஏமேனும் ஒரு தபாத்ோலன கிளிக் 

தசய்யவும்.  

● சேசீர் சுருள் (Symmetrical spiral)  

● ேைக்லக சுருள் (Logarithmic spiral)  

➢ சுைற்சிலய தவளிப் புறோக நகர்த்தும் மபாது சுருள் விரிவாக்க அளவுகலள 

ோற்ற விரும்பினால் spiral expansion slider ஐ நகர்த்ேவும்.  

➢ வலரயும் சன்னல் திலரயில் நேக்கு மவண்டிய அளவு உள்ள சுருள் வரும் 

வலர சுட்டிலய கிலைேட்ைோக இழுக்கவும். 

 
சேச்சீர் சுருள்    ேைக்லக சுருள் 

 

2 பைமகாணங்கலள (Polygon) லய படிநிலைகலள எழுதுக. 

 ➢ பைமகாண உருவம் வலரய (ஐங்மகாணம் - ஐந்து பக்கம் உலைய உருவம் 

என்றும் அறியப்படுகிறது) polygon கருவிலய கருவிபட்லையிலிருந்து 

மேர்ந்தேடுக்கவும்.  

➢ சுட்டியின் வடிவம் Crosshair குறியுைன் கீழ்ப்பகுதியில் பைமகாணம் 

தகாண்டு குறியாக இருக்கும்.  

➢ இப்மபாது வலரயும் பகுதியில் எங்கு ஐங்மகாணம் வலரய மவண்டுமோ 

அங்கு சுட்டியின் இைது தபாத்ோலன அழுத்தி பிடித்ேவாறு நகர்த்ே 

மவண்டும்.  

➢ நீங்கள் விரும்பும் வடிவமுலைய பைமகாணம் உருவானவுைன் சுட்டியின் 

தபாத்ோலன அழுத்துவலே விட்டு விைவும்.  

➢ வலரந்ே பைமகாணத்தின் பக்கங்கலள அதிகரிக்க நீங்கள் வலரந்ே 

பைமகாணத்லே pick கருவி மூைம் மேர்ந்தேடுக்கவும். 

➢ சுட்டிலய பண்பு பட்லையில் உள்ள Number of Points on Polygon 

உலரப்தபட்டியில் கிளிக் தசய்து மேலவயான பக்கங்களின் 

எண்ணிக்லகலய தகாடுக்கவும். 

 

 
ஆறு பக்க பைமகாணம் 

 

4 கட்ைங்கலள (Grid) வலரய படிநிலைகலள எழுதுக. 

 ➢ Graph Paper கருவிலய பயன்படுத்தி குறிப்பிட்ை எண்ணிக்லக வரிலச 

ேற்றும் தநடுவரிலசகலள தகாண்ை ஒரு கட்ைம் வலரயைாம்.  
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➢ கட்ைம் என்பது ேனித்ேனியாக பிரிக்கக் கூடிய பை தசவ்வகங்கள் மசர்ந்ே 

அலேப்பாகும்.  

➢ ஒரு கட்ைகம் வலரய  

➢ பைமகாண கருவியின் மீது அழுத்திக் தகாண்மை இருந்ோல் flyout பட்டி 

மோன்றும். 

➢ flyout பட்டியில் உள்ள Graph Paper கருவிலய கிளிக் தசய்யவும். 

➢ பண்புபட்லையில் உள்ள மேல் ேற்றும் கீழ்ப் பகுதியில் தநடுவரிலச ேற்றும் 

வரிலசகளின் எண்ணிக்லகலய உள்ளிைவும்.  

➢ மேல் பகுதியில் உள்ளிைப்படும் ேதிப்பு தநடுவரிலச எண்ணிக்லகலயயும் 

கீழ்ப் பகுதியில் உள்ளிைப்படும் ேதிப்பு வரிலச எண்ணிக்லகலயயும் 

குறிக்கும். 

➢ வலரயும் பகுதியில் எங்கு கட்ைகம் மோன்ற மவண்டுமோ அங்கு கிளிக் 

தசய்யவும்.  

➢ சுட்டிலய கிலைேட்ைோக இழுப்பேன் மூைம் மவண்டிய கட்ைம் வலரய 

முடியும்.  

➢ லேயப் புள்ளியிலிருந்து தவளிப்புறோக கட்ைங்கள் வலரய shift விலசலய 

விலசலய அழுத்தியவாறு நகர்த்ே மவண்டும்.  

➢ கட்ைங்கலள சதுர வடிவல் அலேக்க Ctrl விலசலய விலசலய 

அழுத்தியவாறு நகர்த்ே மவண்டும். 

 

 
5 பாலேயில் உலரயிலன தபாருத்துேல் பற்றி விரிவாக எழுது. 

 ➢ எந்ே வடிவ பாலேயிலும் உலர சரத்லே தபாருத்ே Corel Draw 

அனுேதிக்கின்றது.  

➢ அது மநர் அல்ைது வலளந்ே மகாடு, ஒரு தசவ்வகம், ஒரு நீள்வட்ைம் 

அல்ைது ேற்தறாரு எழுத்து அல்ைது உலர சரம் என பை வடிவ பாலேகளாக 

இருக்கைாம்.  

➢ உலரயிலன பாலேயில் தபாருத்துவேற்கு Text பட்டியிலிருந்து Fit text to 

path கட்ைலளயிலன பயன்படுத்ேவும்.  

➢ உலரயிலன பாலேயில் தபாருத்துேல்  

➢ Pick கருவி ேற்றும் Shift சாவி தகாண்டு உலர தபாருலளயும் ேற்றும் 

இரண்ைாவது தபாருலளயும் மேர்வு தசய்யவும்.  

➢ Text பட்டியிலிருந்து Fit + Text to path என்பலே மேர்வு தசய்யவும்.  

➢ இரண்ைாவது தபாருளின் பாலேயின் வழி உலரயானது மீண்டும் 

வலரயப்படுகின்றது. 
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பாடம் – 4 

பல்லூடகம் மற்றும் கணிப்பபாறிப் பதிப்பகம் 

 

பகுதி – அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 _________ என்பே ஒன்றிற்கு மேற்பட்ை ஊைக வலகயான உலர, ேலரகலை, 

ஒளிக்காட்சி, அலசவூட்ைல் ேற்றும் ஒலி ஆகியவற்றில் ஏமேனும் ஒரு வலகப் 

பயன்பாட்லைக் குறிக்கும். இ) பல்லூைகம்  

2 பல்லூைகத்தின் குலறபாடுகளில் ஒன்று அேனுலைய _________ அ) விலை 

3 விரிவாக்கம் JPEG ஆ) Joint Photographic experts group  

4 பல்லூைகத்லே உருவாக்க நேக்கு மேலவயானலவ: வன்தபாருள், தேன்தபாருள் 

ேற்றும் _________ ஈ) நிரைாக்க திறன் 

5 சரியான ஒன்லறத் மேர்ந்தேடுத்து பின்வருவனவற்லற தபாருத்துக. 

 1.  உலர - RTF  

2. நிைற்பைம் - TGA  

3. ஒலி - MIDI 

4. ஒளி – MPEG                  

இ) 4, 1, 2, 3 

6 பின்வருவனவற்றில் தபாருந்ோே ஒன்லறக் கண்டுபிடிக்கவும்.  இ) RTF 

7 _________ என்பது அலசயா நிைற்பைங்கலள தோைர்ச்சியான இயக்கோக 

காட்சிப்படுத்தும் தசயல்.  ஈ) அலசவூட்ைல் 

8 இலணயத்தின் மூைம் நிகழ்மநர நிகழ்ச்சிகலள மநரடியாக ஒளிப்பரப்புவலே 

_________ என்கிமறாம். அ) வலை ஒளிப்பரப்பு 

9 GIF பயன்படுத்தும் வண்ண மேைல் அட்ைவலண _________ அ) 8 பிட் 

10 RTF மகாப்பு வடிவத்லே அறிமுகப்படுத்தியது _________ ஆ) Micorsoft  

  

பகுதி – ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 வலரயறு – பல்லூைகம் ேற்றும் அேன் சிறப்பம்சம். 

 ➢ பல்மவறு வளங்களான நிைற்பைம், உலர, வலரகலை, ஒளிக்காட்சி, ஒலி 

ேற்றும் ஒளி ஆகியவற்லற ஒன்றிலணத்து, ேரவுகலள 

ஒற்லறத்ேளத்திற்கு ோற்ற பயனர்களுக்கு பல்லூைகம் அனுேதி 

அளிக்கிறது. 

 

2 பல்லூைக கூறுகலளப் பட்டியலிடுக. 

 ➢ பல்லூைகம் 5 முக்கிய கூறுகலளக் தகாண்டுள்ளது. அலவ உலர, 

நிைற்பைம், ஒலி, ஒளிக்காட்சி ேற்றும் அலசவூட்ைல். 
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6  நிைற்பை மகாப்பு வடிவங்கலளப் பட்டியலிடுக. 

 ➢ TIFF(Tagged Image File Format)  

➢ BMP(Bitmap)  

➢ DIB(Device IndependentBitmap)  

➢ GIF(Graphics Interchange Format)  

➢ JPEG(Joint Photographic Experts Group)  

➢ TGA(Tagra)  

➢ PNG(Portable Network Graphics) 

 

7 ஒலி மகாப்பு வடிவங்கலளப் பட்டியலிடுக. 

 ➢ WAV (Waveform Audio File Format)  

➢ MP3(MPEG layer-3 Format)  

➢ OGG  

➢ AIFF (Audio Interchange File Format)  

➢ WMA (Windows Media Audio)  

➢ RA (Real Audio Format)  

 

8 ஒளிக்காட்சி மகாப்பு வடிவங்கலளப் பட்டியலிடுக. 

 ➢ AVI(Audio/Video Interleave)  

➢ MPEG(Moving Picture Experts Group) 

 

9 வலரயறு – பல்லூைக உருவாக்கம் 

 ➢ பல்லூைகத்லே உருவாக்குவேற்கு மபாதுோன மநரம் ேற்றும் திறலேயான 

திட்ைமிைல் ஆகியலவ மேலவப்படுகின்றன.  

➢ இது திட்ைப்பணி சுமூகோக தோைரவும் ேற்றும் ேகவல் இைக்கு 

பார்லவயாளர்கலளச் தசன்றலையவும் உறுதி தசய்கிறது.  

 

10 பல்லூைக உருவாக்க குழு உறுப்பினர்கலள பட்டியலிடுக. 

 ➢ ேயாரிப்பு மேைாளர் 

➢ தபாருளைக்க வல்லுநர் 

➢ ஸ்கிரிப்ட் எழுத்ோளர் 

➢ உலர பதிப்பாளர்  

➢ பல்லூைக வடிவலேப்பாளர் 

➢ கணினி வலரகலைகலைஞர் 

➢ ஒலி ேற்றும் ஒளிக்காட்சி வல்லுநர் 

➢ கணினி நிரைர் 

➢ வலை வல்லுநர் 

 

பகுதி - இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

3 உருவாக்க குழு உறுப்பினர்களின் பணிகள் ேற்றும் தபாறுப்புகலளப் பற்றி எழுதுக. 
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 பல்லூைக உருவாக்கத்தில் அதிகபட்ச பைலன உயர்ேர திறலேயுைன் தபறும் 

வலகயில் குழு உறுப்பினர்கலள மேைாண்லே தசய்வது கட்ைாயோகும். நல்ை 

ேரோன உயர்ந்ே பல்லூைக உருவாக்க பயன்பாட்டிற்கு பின்வரும் 

உறுப்பினர்கலளக் தகாண்ை வல்லுநர் குழு மேலவப்படுகிறது. 

➢ ேயாரிப்பு மேைாளர் 

➢ தபாருளைக்க வல்லுநர் 

➢ ஸ்கிரிப்ட் எழுத்ோளர் 

➢ உலர பதிப்பாளர்  

➢ பல்லூைக வடிவலேப்பாளர் 

➢ கணினி வலரகலைகலைஞர் 

➢ ஒலி ேற்றும் ஒளிக்காட்சி வல்லுநர் 

➢ கணினி நிரைர் 

➢ வலை வல்லுநர் 

 

4 பல்லூைகத்தில் உள்ள பல்மவறு மகாப்பு வடிவங்கள் பற்றி விவரிக்கவும். 

 உலர வடிவங்கள் 

• RTF(Rich Text Format)  

• Plain Text 

நிைற்பை வடிவங்கள் 

• TIFF (Tagged Image File Format)  

• BMP (Bitmap)  

• DIB (Device IndependentBitmap)  

• GIF (Graphics Interchange Format)  

• JPEG (Joint Photographic Experts Group)  

• TGA (Tagra)  

• PNG (Portable Network Graphics)  

இைக்க ஒலி மகாப்பு வடிவங்கள் 

• WAV (Waveform Audio File Format) 

• MP3 (MPEG layer-3 Format)  

• OGG  

• AIFF (Audio Interchange File Format)  

• WMA (Windows Media Audio) 6. RA (Real Audio Format)  

இைக்க ஒளிக்காட்சி மகாப்பு வடிவங்கள் 

• AVI(Audio/Video Interleave)  

• MPEG(Moving Picture Experts Group) 

 

பகுதி - ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 

  

1 பல்லூைக தசயல்கள் பற்றி விரிவாக விளக்கவும். 

 ➢ பல்லூைகத்லே உருவாக்குவேற்கு மபாதுோன மநரம் ேற்றும் திறலேயான 

திட்ைமிைல் ஆகியலவ மேலவப்படுகின்றன. இது திட்ைப்பணி சுமூகோக 
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தோைரவும் ேற்றும் ேகவல் இைக்கு பார்லவயாளர்கலளச் தசன்றலையவும் 

உறுதி தசய்கிறது. சிக்கைான  

➢ பல்லூைக திட்ைங்கலள உருவாக்குவேற்கான படிநிலைகள் பின்வருோறு.  

1. கருத்துரு பகுப்பாய்வு ேற்றும் திட்ைமிைல்  

➢ பல்லூைகத்லே உருவாக்கும் தசயைானது கருத்துருலவ 

தோைக்கப்புள்ளியாக தகாண்டு தோைங்குகிறது. 

➢ கருத்துரு பகுப்பாய்வு தபாருத்ேோன கருப்தபாருள், வரவு- தசைவு 

திட்ைம் ேற்றும் மேர்வு தசய்ே கருப்தபாருளின் தபாருளைக்கத்தின் 

இருப்பு ஆகியவற்லற அலையாளம் காண்கின்றது.  

2. திட்ை வடிவலேப்பு  

➢ ஒருமுலற கருப்தபாருலள இறுதி தசய்ேப்பிறகு, பல்லூைகத்தின 

திட்ைத்திற்கான மநாக்கங்கள், குறிக்மகாள்கள் ேற்றும் 

தசயல்பாடுகள் ஆகியலவ வடிவ லேக்கப்படுகின்றன. 

3. முன் – உருவாக்குேல் (Pre – Production)  

➢ திட்ைமிைல் ேற்றும் வடிவலேத்ேலின் அடிப்பலையில் திட்ைத்லே 

உருவாக்குவது மேலவயானது ஆகும்.  

4. வரவு – தசைவு திட்ைமிைல்  

➢ ஆமைாசகர்கள், வன்தபாருள், தேன்தபாருள், பயணம், ேகவல் 

தோைர்பு ேற்றும் பிரசுரித்ேல் மபான்ற ஒவ்தவாரு நிலையிலும் 

அலனத்து பல்லூைக திட்ைங்களுக்கும் வரவு – தசைவு திட்ைம் 

மோராயோகக் கணக்கிைப்படுகிறது.  

5. பல்லூைகத்லே உருவாக்கும் குழு  

➢ உயர்ந்ே பல்லூைக திட்ைத்லே உருவாக்கும் குழுவிற்கு அந்ே 

குழுவின் ஒட்டு தோத்ே முயற்சி மேலவ.  

➢ இந்ே குழுவானது ஸ்கிரிப்ட் எழுத்ோளர், ேயாரிப்பு மேைாளர், 

பதிப்பாசிரியர், வலரகலை வடிவலேப்பாளர், பல்லூைக 

வடிவலேப்பாளர் ேற்றும் வலை வல்லுநர் மபான்ற பல்மவறு 

பேவிகலளயும் ேற்றும் தபாறுப்புகலளயும் தசய்யும் உறுப்பினர்கலள 

தகாண்ைது.  

6. வன்தபாருள் / தேன்தபாருள் மேர்ந்தேடுத்ேல்  

➢ வன்தபாருளானது மேர்ந்தேடுத்ே மவகோன லேயச்தசயைகம், RAM 

ேற்றும் திலரயகம், பதிவுகலளச் மசமிக்க மேலவயான வட்டுகள் 

ஆகியவற்லற உள்ளைக்கியது.  

➢ தபாருத்ேோன தேன்தபாருள் ேற்றும் மகாப்பு வடிவங்கலளத் 

மேர்ந்தேடுத்ேல் என்பது உருவாக்கப்படும் திட்ைப் பணிக்கு 

கிலைக்கும் நிதிலயப் தபாறுத்ோகும். 

7. தபாருளைக்கத்லே வலரயறுத்ேல்  

➢ தபாருளைக்கம் என்பது தபாருளைக்க வல்லுநரால் பல்லூைக 

வடிவலேப்பாளருக்கு வைங்கப்படும் ேகவல்கள் (Stuffed) ஆகும்.  

8. கட்ைலேப்லப ேயார் தசய்ேல்  

➢ கட்ைலேப்பு தசயல்பாடுகள், ஒவ்தவாரு தசயல்பாட்டிற்குோன 

தபாறுப்பாளர் ேற்றும் ஒவ்தவாரு தசயல்பாட்டிற்குோன தோைக்க / 

முடிவு மநரம் ஆகியவற்லற வலரயறுக்கிறது.  

9. உருவாக்குேல்  

➢ பல்லூைக பயன்பாட்டில் முன் – உருவாக்குேல் தசயல்பாட்டிற்கு 

பிறகு, இந்ே படிநிலை தோைங்குகிறது. இது பின்னணி இலசலயத் 
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மேர்ந்தேடுத்ேல், ஒலிப்பதிவு மபான்ற தசயல்பாடுகலள 

உள்ளைக்கியது.  

10. மசாதித்ேல்  

➢ திட்ைத்லே பிரோண்ைோக உருவாக்குவேற்கு முன், ோதிரி 

திட்ைத்லே முழுவதுோக மசாதித்ேல் மவண்டும்.  

11. ஆவணப்படுத்துேல்  

➢ கணிப்தபாறி மேலவயில் தோைங்கி மசாதித்ேல் முடியும் வலர 

அலனத்து ேதிப்புமிக்க ேகவல்கலளயும் ஆவணப்படுத்துேல் 

தகாண்டிருக்கும்.  

12. பல்லூைக திட்ைத்லே வைங்குேல் (Delivering)  

➢ பல்லூைக பயன்பாடுகள் CD / DVDகளில் அல்ைது இலணய ேளத்தில் 

சிறப்பாக வைங்குகிறது.  

 

4 பல்லூைக உருவாக்க குழுவின் பணிகள் ேற்றும் தபாறுப்புகள் விரிவாக எழுேவும். 

 பல்லூைக உருவாக்கத்தில் அதிகபட்ச பைலன உயர்ேர திறலேயுைன் தபறும் 

வலகயில் குழு உறுப்பினர்கலள மேைாண்லே தசய்வது கட்ைாயோகும். நல்ை 

ேரோன உயர்ந்ே பல்லூைக உருவாக்க பயன்பாட்டிற்கு பின்வரும் 

உறுப்பினர்கலளக் தகாண்ை வல்லுநர் குழு மேலவப்படுகிறது. 

➢ ேயாரிப்பு மேைாளர் 

• பல்லூைக உருவாக்குேலில், குறித்ே மநரத்தில் முழு ேரத்துைன் 

பல்லூைக திட்ை உருவாக்கத்லே வலரயறுப்பது ேற்றும் 

ஒருங்கிலணப்பது ேயாரிப்பு மேைாளரின் பங்கு ஆகும். 

➢ தபாருளைக்க வல்லுநர் 

• தபாருளைக்க வல்லுநர் என்பவர் ஏற்கனமவ திட்ைமிைப்பட்ை 

பயன்பாட்டின் தபாருளகத்லேப் பற்றிய அலனத்து ஆராய்ச்சி 

தசயல்பாடுகலளயும் தசய்வேற்கு தபாறுப்பானவர் ஆவார். 

➢ ஸ்கிரிப்ட் எழுத்ோளர் 

• ஸ்கிரிப்ட் எழுத்ோளர் கருத்துருக்கலள முப்பரிோன சூைல்களில் 

காட்சிப்படுத்துகிறார். 

➢ உலர பதிப்பாளர்  

• பல்லூைக உருவாக்குேலின் தபாருளைக்கம் எப்தபாழுதும் 

ேருக்கரீதியான ஓட்ைோக இருத்ேல் மவண்டும். 

➢ பல்லூைக வடிவலேப்பாளர் 

• பல்லூைக வடிவலேப்பாளர் பல்லூைகத்தின் அலனத்து அடிப்பலைத் 

தோகுதிகளான வலரகலை, உலர, ஒலி, இலச, ஒளிக்காட்சி, 

புலகப்பைம் ேற்றும் பலைப்பாக்க தேன்தபாருலளப் பயன்படுத்தி 

அலசவூட்ைல் மபான்றவற்லற ஒருங்கிலணப்பார். 

➢ கணினி வலரகலைகலைஞர் 

• நிரலின் வலரகலை கூறுகளான பின்னணி, புல்ைட்கள், 

தபாத்ோன்கள், பாைப்பதிப்பாய்வு, 3-D தபாருள்கள், அலசவூட்ைல் 

ேற்றும் சின்னங்கள் ஆகியவற்லறக் லகயாளும் பங்கிலன கணினி 

வலரகலை கலைஞர் வகிக்கிறார். 

➢ ஒலி ேற்றும் ஒளிக்காட்சி வல்லுநர் 
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• எடுத்துலரத்ேல் ேற்றும் மசமிக்கப்பட்ை ஒளிக்காட்சிகலளப் 

பல்லூைக நிகழ்த்துேலில் லகயாளத் மேலவப்படுபவமர ஒலி ேற்றம் 

ஒளிக்காட்சி வல்லுநர் ஆவார். 

➢ கணினி நிரைர் 

• கணினி நிரைர் தபாருத்ேோன தோழியில் குறிமுலற அல்ைது 

ஸ்கிரிப்ட் வரிகலள எழுதுகிறார். 

➢ வலை வல்லுநர் 

• ஒரு இலணய வலைப்பக்கத்லே உருவாக்கி அலே பராேரிப்பது 

வலை வல்லுநரின் தபாறுப்பாகும். 

 

5 பல்லூைக மகாப்பில் உள்ள தவவ்மவறு மகாப்பு வடிவங்கலள விவரிக்கவும். 

 உலர வடிவங்கள்  

1. RTF முேன்லே மகாப்பு வடிவம் RTF (Rich Text Format)  

• லேக்மராசாப்ட் நிறுவனத்ோல் 1987 ஆம் ஆண்டு பிரசுரிக்கப்பட்ை 

ேயாரிப்புகளின் குறிப்புகள் ேற்றும் குறுக்கு பணித்ேள 

ஆவணங்களின் பரிோற்றங்கமளாடு அறிமுகப்படுத்ேப்பட்ைது.  

2. Plain Text  

• Plain Text Plain Text  மகாப்புகலள பை உலர பதிப்பான்களில் 

திறக்கைாம், படிக்கைாம் ேற்றும் பதிப்பாய்வு தசய்யைாம்.  

நிைற்பை வடிவங்கள்  

1. TIFF (Tagged Image File format)  

• இந்ே வடிவம் கணிப்தபாறி பதிப்பக உைகில் (அதிக ேரோன 

தவளியீடு) தபாதுவானது ஆகும்.  

• இது தபரும்பாலும் அலனத்து தேன்தபாருள் தோகுப்புகலள 

ஆேரிக்கிறது.  

2. BMP (Bitmap)  

• BMP மிகவும் தபரியது ேற்றும் குறுக்கேற்றது. எனமவ, அதிக 

தேளிவுத்திறன் அல்ைது தபரிய நிைற்பைங்களுக்காக BMP 

பயன்படுத்ேப்படுகிறது. 

3. DIB (Device Independent Bitmap)  

• DIB வடிவம் BMP-லய ஒத்ேோகும். இது மகாப்புகலள பல்மவறு 

சாேனங்களில் காண்பிக்க அனுேதிக்கிறது.  

4. GIF (Graphics Interchange Format)  

• GIF என்பது குறுக்கப்பட்ை நிைற்பை வடிவோகும்.  

• தபரும்பாைான கனிணி வண்ண நிைற்பைங்கள் ேற்றும் பின்னணிகள் 

GIF மகாப்புகளாகும்.  

5. JPEG (Joint Photographic Experts Group)  

• JPEG அதிகபட்ச நிைற்பை குறுக்கத்லே அலைவேற்காக 

வடிவலேக்கப்பட்டுள்ளது.  

• இது புலகப்பைம், இயற்லக, கலை, மவலைப்பாடு ேற்றும் 

அலேப்மபான்ற தபாருள்களுைன் நன்றாக மவலை தசய்யும்.  

6. TGA (Tagra)  

• TGA அதிக தேளிவுத்திறன் நிைற்பைங்களுக்கான முேல் பிரபைோன 

வடிவோகும். தபரும்பான்லேயான ஒளிக்காட்சி பிடிப்பு பைலககள் 

TGA-லவ ஆேரிக்கின்றன.  
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7. PNG (Portable Network Graphics)  

• PNG குலறந்ே இைப்பு, சிறியது ேற்றும் நன்கு குறுக்கப்பட்டு தசவ்வக 

நிைற்பைங்களாக மசமிக்கப்படும் ஒரு நீட்டிப்பு மகாப்பு வடிவோகும்.  

இைக்க ஒலி மகாப்பு வடிவங்கள்  

1. WAV (Waveform Audio File Format)  

• WAV விண்மைாஸில் குறுக்கப்பைாே ஒலி மகாப்புகலளச் மசமிக்கும் 

மிகவும் பிரபைோன ஒலி மகாப்பு வடிவோகும்.  

2. MP3 (MPEG layer – 3 Format)  

• இலசலய மசமிக்கவும் பதிவிறக்கம் தசய்யவும் மிகவும் பிரபைோன 

வடிவம் MPEG Layer-3 வடிவோகும்.  

3. OGG  

• OGG சிறந்ே ஓட்ைத்திலன அலைவேற்காக வடிவலேக்கப்பட்ை 

இைவச திறந்ே மூை தகாள்கைன் (Container) வடிவோகும்.  

4. AIFF (Audio Interchange File Formate)  

• Mac பயன்படுத்தும் WAV மகாப்புகலளப் மபால் Apple நிறுவனம் 

பயன்படுத்தும் ேரோன ஒலி வடிவம் இது ஆகும்.  

5. WMA (Windows Media Audio)  

• மிகவும் பிரபைோன WMA வடிவத்தின் உரிலேயாளர் லேக்மரா சாப்ட் 

ஆகும். பதிப்புரிலே (Copy right) பாதுகாப்பிற்காக DRM (Digital Right 

Management) திறன்கமளாடு வடிவலேக்கப்பட்டுள்ளது.  

6. RA (Real Audio Format)  

• RA வடிவம் இலணயத்தில் ஒலியின் ஓட்ைத்திற்காக 

வடிவலேக்கப்பட்ைோகும்.  

இைக்க ஒளிக்காட்சி மகாப்பு வடிவங்கள்  

1. AVI (Audio / Video Interleave)  

• AVI ஒரு விண்மைாஸிற்கான ஒரு ஒளிக்காட்சி மகாப்பு வடிவோகும். 

இங்கு, ஒலி ேற்றும் பைத்தின் கூறுகலளக் மகாப்பில் ோற்று 

தநடுவரிலச தோகுப்பில் (interleave chunk) மசமிக்கப்படுகிறது.  

2. MPEG (Moving Picture Experts Group)  

• MPEG என்பது இைக்க ஒளிக்காட்சி ேற்றும் ஒலி குறுக்கத்லே ISO 

(International Standards Organization) குழுவினரால் உருவாக்கப்படும் 

ஒரு ேரநிலை ஆகும்.  
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பாடம் – 5 

அடடாப் ஃப்ளாஷ் ப்பராப்பஷனல் CS6 

 

பகுதி – அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 Adobe Flash நிரல் மூைம் நீங்கள் எேலன உருவாக்க முடியும்? அ) அனிமேஷன்கள் 

ஈ) மேமை உள்ள அலனத்தும் 

2 Flash பணியிை லேயத்தின் நடுவில் உள்ள தபரிய தவள்லள தசவ்வக வடிவம் --- 

அ) மேலை  

3 ஒரு புதிய Flash ஆவணத்லே எவ்வாறு உருவாக்குவாய்? இ) File → New  

4 தகாைாநிலை பணித்ேளத்தின் நிறம் தவள்லள. இலே ோற்ற ---- 

மேர்ந்தேடுக்கவும். ஆ) Modify → Document 

5 Flash மகாப்புகள் ---- எனவும் அலைக்கப்படுகிறது. ஆ) Flash Movies  

6 கவனத்லே ஈர்க்கும் வலகயிைான போலககலள (Banner) ---- மூைம் 

உருவாக்கைாம். இ) Flashl 

7 Flash மகாப்பின் தகாைாநிலை விரிவாக்கம் ---  ஈ) .fla 

8 Flashல் நீங்கள் உருவாக்கும் எந்ே உள்ளைக்கோயினும் அது --- என்று 

அலைக்கப்படுகிறது. ஈ) பயன்பாடு 

9 நீங்கள் துரிலகலய பயன்படுத்தி வலரவது மபான்று மகாடுலகள வலரய உேவும் 

கருவி அ) Brush Tool  

10 கீழ்கண்ை எந்ே கருவி, கருவிப் பைகத்தில் ஒமர குழுவில் இைம்தபறவில்லை இ) 

Line Tool  

11 Ovalகருவிலய பயன்படுத்தி எவ்வாறு ஒரு வட்ைத்லே வலரயைாம்? 

ஈ) Shift விலசலய அழுத்தி லவத்துக் தகாண்மை. 

12 எந்ே கருவி ஒரு வலரபைத்தின் குறிப்பிட்ை பகுதிலய தபரிோக்கி காட்டும். இ) The 

Zoom tool  

  

II மகாடிட்ை இைங்கலள நிரப்புக 

  

1 பணித்ேளத்தில் ---------- கருவிலய பயன்படுத்தி ஒரு மநர்மகாட்லை 

வலரயைாம். (Line Tool – லைன் கருவி) 

2 ஒரு வட்ைம் வலரய Oval கருவிலய கிளிக் தசய்து ---- விலசலய அழுத்தி 

தகாண்மை நகர்த்ே மவண்டும். (Shift) 

3 நீங்கள் ---- கருவி மூைம் சதுரம் வலரய முடியும். (Rectangle) 

4 சாோரன அழிப்பான் மபான்று தபாருட்கலள அழிப்பேற்கு ----- உேவுகிறது. 

(Eraser) 

5 Flash மகாப்புகள் ோனாகமவ ---- விரிவுைன் உருவாகும் (.fla) 
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பகுதி – ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 Flash என்பது என்ன? 

 ➢ அமைாப் ஃப்ளாஷ் ப்தராப்பஷ்னல் CS6 என்பது ஒரு தேன்தபாருள் ஆகும்.  

➢ இது அலசவூட்ைங்கலள உருவாக்க பயன்படுகிறது. 

➢ இது பல்மவறு கருவிகலளக் தகாண்டுள்ளது. அலவ அடிப்பலை 

தபாருள்கலள வலரயவும் ேற்றும் காட்சிகலள உருவாக்கவும் 

பயன்படுகிறது.  

➢ இது அமைாப் நிறுவனத்ோல் உருவாக்கப்பட்டுள்ளது. 

 

3 காைக்மகாட்டின் (Time line) ன் மேலவ என்ன? 

 ➢ (Timeline) காைக்மகாடு என்பது Flash-ன் மிக முக்கியோன கூறுகளில் 

ஒன்றாகும்.  

➢ இது மேலைக்கு கீமை அலேந்துள்ளது.  

➢ இது ஒவ்தவாரு உறுப்பு மோற்றத்லேயும் அனிமேஷலனயும் குறிக்க 

பயன்படுத்ேப்படுகிறது.  

 

பகுதி - இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

1 கீழ்கண்ை தசயல்கலள தசய்ய உேவும் கருவிகலள கூறுக.  

அ. மகாடு வலரேல்  

ஆ. ேற்மபாக்கு உருவம் வலரேல்  

இ. நீங்கள் வலரந்ேவற்லற அழித்ேல் 

 

 அ. மகாடு வலரேல்  

➢ Line கருவி (N) இது மநர்மகாடுகலள வலரவேற்குப் பயன்படுகிறது.  

➢ தசங்குத்து, கிலை ேட்ை ேற்றும் 450 மூலைவிட்ை மகாடுகலள 

வலரவேற்கு Shift விலசலய அழுத்திப் பிடிக்க மவண்டும். 

 ஆ. ேற்மபாக்கு உருவம் வலரேல்  

➢ Pencil கருவி இது ேற்மபாக்காக (freehand) மகாடுகள் ேற்றும் வடிவங்கலள 

வலரயப் பயன்படுகிறது.  

➢ தபன்சில் முலற (Mode) விருப்பத்தில் உள்ள பட்டி பின்வரும் 

கட்ைலளகலள காட்டும். 

• Straighten-மநர்க்மகாட்டிலன வலரவேற்கு,  

• Smooth – வலள மகாட்டிலன வலரவேற்கு  

• Ink - அளவுமகாைற்ற வலரபைங்கலள எந்ே ோற்றமும் இன்றி வலரய 

 இ. நீங்கள் வலரந்ேவற்லற அழித்ேல் 

➢ Eraser கருவி (E) இது மகாடுகள் ேற்றும் உட்பரப்புகலள (Fill) அழிக்கப் 

பயன்படுகிறே 
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பகுதி - ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 

  

1 Flash சன்னல்திலரயில் பயன்படுத்தும் கூறுகலள விவரி. 

 ஃப்ளாஷ் சன்னல் திலர கூறுகள் (அ) பகுதிகள்  

➢ ஃப்ளாஷ் சன்னல் திலர நான்கு பகுதிகளாக (அ) கூறுகளாக 

பிரிக்கப்பட்டுள்ளது.  

1. பணித்ேளம் ேற்றும் ஒட்டுப்பைலக (Stage and paste Board)  

2. காைக்மகாடு (Timeline)  

3. கருவிகள் பைகம் (Tools Panel) 

4. பண்பு மசாதிப்பான் (Property Inspector) 

1. பணித்ேளம் ேற்றும் ஒட்டுப்பைலக (பணிப்பகுதி)  

➢ பணித்ேளத்தின் நடுவில் உள்ள தசவ்வக தவள்லளப் பகுதி மேலை (Stage) 

என அலைக்கப்படுகிறது.  

➢ அலசவுப் பைத்திற்கான அலசவூட்ைங்கள், தபாருட்கள் ேற்றும் காட்சிகள் 

ஆகியவற்லற உருவாக்க, பதிப்பிக்க இருத்திலவக்க ேற்றும் இயக்க இந்ே 

மேலை உேவுகிறது. 

➢ ஃப்ளாஷ்-ல் பணித்ேளத்லே சுற்றியுள்ள சாம்பல் நிற பகுதி ஒட்டுப்பைலக 

(Pasteboard) எனப்படும். இந்ே ஒட்டு பைலகயில் நீங்கள் தபாருள்கலள 

உருவாக்கவும், பதிப்பிக்கவும் முடியும். 

2. காைக்மகாடு  

➢ காைக்மகாடு என்பது ஃப்ளாஷ்-ன் மிக முக்கியோன கூறுகளில் ஒன்றாகும்.  

➢ பணித்ேளப் பகுதியின் கீமை அலேந்துள்ளது.  

➢ இது ஒவ்தவாரு உறுப்பின் மோற்றத்லேயும் ேற்றும் அலசவூட்ைத்லேயும் 

தேளிவாக காட்ை பயன்படுகிறது. 

➢ காைக்மகாடு என்பது சைனப்பைத்லே உருவாக்கும் ஒவ்தவாரு சட்ைகம், 

அடுக்கு ேற்றும் காட்சியின் பதிவு ஆகும்.  

3. ஃப்ளாஷ் கருவிகள் பைகம்  

➢ ஃப்ளாஷ் கருவிகள் பைகம் நீங்கள் மேலையில் வலரகலைலய உருவாக்க, 

மேர்ந்தேடுக்க (அ) பதிப்பிக்கத் மேலவயான கருவிகலள தகாண்டுள்ளது. 

4. பண்பு மசாதிப்பான் (Property inspector)  

➢ இது தகாைாநிலையாக Flash பணியிைத்தின் வைது பக்கத்தில் மோன்றும்.  

➢ இது நூைகப்பைகத்துைன் இலணக்கப்பட்டிருக்கும்.  

➢ இது மேர்ந்தேடுக்கப்பட்ை தபாருளின் பண்புகள் ேற்றும் விருப்பங்கலளக் 

காட்டுவமோடு அவற்லற ோற்றவும் அனுேதிக்கிறது.  

➢ தபாருள் (object) என்பது உலரயாகமவா, பைோகமவா, மகாைாகமவா அல்ைது 

மவறு வடிவோகமவா இருக்கைாம். 

 

2 Tools பைகத்தில் காணப்படும் கருவிகள் சிைவற்லற விவரி. 

➢  ➢ Selection கருவி (V) இந்ேகருவி ஒரு தபாருள் (அ) ஒரு தபாருளின் 

பகுதியாகிய தவளிக்மகாடு ேற்றும் உட்பரப்பு (Stroke & Fill) ஆகியவற்லறத் 

மேர்ந்தேடுக்க பயன்படுகிறது.  
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➢ Sub Selection கருவி (A) இந்ே கருவி ஒரு தபாருலள மேர்ந்தேடுக்க, 

இழுக்க, மீள் வடிவலேக்க பயன்படுகிறது. 

➢ Free Transform கருவி (Q) இது தபாருள்கலள சுைற்ற, அளவிை, வலளக்க 

ேற்றும் உருக்குலைக்க பயன்படுகிறது. 

➢ 3D Rotation கருவி (W) இது மேலையில் முப்பரிோண தவளியில் சைனப் 

பைத்துண்டுகுகலள (Movie Clips) சுைற்றுவேன் மூைம் முப்பரிோண 

விலளவுகலள உருவாக்க பயன்படுகிறது. 

➢ Pen கருவி (P) இது நங்கூரப் புள்ளிகள் எனப்படும். தோைர் புள்ளிகலள 

உருவாக்குவேன் மூைம் மகாடுகள் ேற்றும் வலளமகாடுகலள வலரவேற்கு 

பயன்படுகிறது. 

➢ Text கருவி (T) இது உலரலய உருவாக்க ேற்றும் பதிப்பிக்க பயன்படுகிறது.  

➢ Line கருவி (N) இது மநர்மகாடுகலள வலரவேற்குப் பயன்படுகிறது. 

➢ Rectangle Tool (R) இது தசவ்வகம் வலரயப் பயன்படுகிறது. Shift 

அழுத்திப்பிடிப்பேன் மூைம் சதுரம் வலரயைாம். 

➢ Oval கருவி (O) இது நீள்வட்ை வடிவங்கலள வலரவேற்கு பயன்படுகிறது. 

சரியான வட்ைத்லே வலரவேற்கு Shift விலசலய அழுத்திப் பிடிக்க 

மவண்டும். 

➢ Poly Star கருவி இது பை மகாணம் ேற்றும் நட்சத்திரங்கலள வலரய 

பயன்படுகிறது. 

➢ Pencil கருவி இது ேற்மபாக்காக (freehand) மகாடுகள் ேற்றும் வடிவங்கலள 

வலரயப் பயன்படுகிறது. 

➢ Brush கருவி (B) இது தூரிலககள் மபான்ற மகாடுகள் (Paint) வலரவேற்கு 

பயன்படுகிறது. 

➢ Bone கருவி இது இலணப்புகலளக் தகாண்ை தபாருட்கலள அலசவூட்ைம் 

தசய்ய பயன்படுகிறது. 

➢ Eraser கருவி (E) இது மகாடுகள் ேற்றும் உட்பரப்புகலள (Fill) அழிக்கப் 

பயன்படுகிறது.  

➢ Hand கருவி (H) இது மேலைலய நகர்த்ே பயன்படுகிறது. ஒட்டுபைலகயில் 

எங்கு மவண்டுோனாலும் பணித்ேளத்லே இழுத்து நகர்த்ேைாம்.  

➢ Zoom கருவி (Z) இது மேலைப் பகுதிலய தபரிோக ோற்றப் பயன்படுகிறது. 

➢ Stroke Color கருவி இது வலரயப்பட்ை தபாருள்களின் தவளிக்மகாட்டின் 

நிறத்லே ோற்றி அலேக்கப் பயன்படுகிறது. 

➢ Fill Color கருவி இது வலரயப்பட்ை தபாருள்களின் உட்பரப்பின் 

வண்ணத்லே ோற்றப் பயன்படுகிறது. 
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பாடம் – 6 

ஆட்டடாடகட் 2016 

பகுதி – அ 

I சரியான விலைலயத் மேர்ந்தேடுத்து எழுதுக 

  

1 ஆட்மைாமகட் என்பது _________ தேன்தபாருளாகும். ஆ) Computer-aided design 

(CAD) and drafting  

2 ஆட்மைாமகட் 2016ஐ உருவாக்கி விற்பலன தசய்யும் நிறுவனம் _________  இ) 

Autodesk, Inc.  

3 சிவப்பு நிற “A” தபாத்ோலனக் கிளிக் தசய்ோல் மோன்றும் பட்டி _________ அ) 

Application  

4 பயன்பாட்டுப் பட்டியின் மேல் பகுதியில் மோன்றும் பட்லை எது? ஆ) Search  

5 கட்ைலளச் சாளரம் மோன்றவில்லைதயனில் எந்ே விலசப்பைலக 

குறுக்குவழிகலளப் பயன்படுத்ே மவண்டும்? ஆ) Ctrl + 9  

6 UCS என்பது எேன் குறுக்கம்? அ) User Coordinate System  

7 கட்ைங்கலள (grid) காண்பிக்கவும், ேலறக்கவும் (ON or OFF) விலசப்பைலகயில் 

எந்ே தசயல்பாட்டு விலசலய அழுத்ே மவண்டும்? ஈ) F7 

  

பகுதி – ஆ 

II மூன்று வரிகளில் விலையளிக்கவும் 

  

1 ஆட்மைாமகலை எவ்வாறு தோைங்குவாய்? 

 ➢ ஆட்மைாமகட் 2016 ஐ தோைங்க, திலரமுகப்பில் உள்ள Auto CAD 2016 – 

English பணிக்குறிலய இருமுலற கிளிக் தசய்ய மவண்டும். 

➢ (அல்ைது) Start > All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016 

– English என்ற வரிலசயில் கிளிக் தசய்ய மவண்டும். 

 

6 லைன் (LINE) கட்ைலளலயப் பயன்படுத்தும் மபாது பைமகாணத்லே முடிக்கப் 

பயன்படும் விலரவான வழிமுலறலயக் கூறு. 

 ➢ இரண்டு அல்ைது அேற்கு மேற்பட்ை தோைர்ச்சியான மகாடுகலள வலரயும் 

மபாது, Close விருப்போனது முேல் மகாட்டின் தோைக்கப் புள்ளிலயயும், 

கலைசி மகாட்டின் முடிவுப் புள்ளிலயயும் இலணக்கப் பயன்படுகிறது. 

 

7 லைன் கட்ைலள ேற்றும் தரக்ைாங்கல் கட்ைலளலயப் பயன்படுத்தி தசவ்வகம் 

வலரயும் மபாது ஏற்படும் நலைமுலற சிக்கல்கலளக் கூறு. ஏன் ஒன்லற விட்டு 

ேற்தறான்லறப் பயன்படுத்ே மவண்டும்? 

 ➢ லைன் கட்ைலளலயப் பயன்படுத்தியும் தசவ்வகம் வலரய முடியும். ஆனால் 

அதில் சிை குலறபாடுகள் உள்ளன.  

➢  மகாண அளவுகள் 90 டிகிரி உள்ளனவா என சரிபார்க்க மவண்டும்.  

➢ ஒவ்தவாரு மகாடும் ேனித்ேனி தபாருளாக இருக்கும். ஒரு மகாட்டின் மீது 

கிளிக் தசய்ோல் அந்ே மகாடு ேட்டுமே மேர்வு தசய்யப்படும். ேற்ற மகாடுகள் 

மேர்வு தசய்யப்பைாது.  
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➢ ஆலகயால் ஆட்மைாமகட் 2016இல் உள்ள RECTANG கட்ைலள, சரியான 

மகாண அளவுகளுைன் ஒரு தசவ்வகத்லே ஒமர தபாருளாக வலரய வழி 

வகுக்கிறது.  

➢ RECTANG கட்ைலளலயப் பயன்படுத்தி வலரயப்பட்ை தசவ்வகத்தின் 

எந்ேதவாரு இைத்திலும் கிளிக் தசய்து முழு தசவ்வகத்லேயும் 

மேர்ந்தேடுக்க முடியும். 

 

9 ஆர்க் ேற்றும் சர்க்கிள் தபாத்ோன்கள் எந்ே ரிப்பன் கன்ட்மரால் மபனலில் உள்ளன? 

 ➢ ஆர்க் ேற்றும் சர்க்கிள் தபாத்ோன்கள் ரிப்பனில் உள்ள Draw மபனலில் ஒரு 

குழுவாக அலேக்கப்பட்டிருக்கும். 

 

பகுதி – இ 

III ஒரு பத்தியளவில் விலையளிக்கவும் 

  

1 தபாருள்கலள உருவாக்குவேற்கான ஏமேனும் மூன்று கட்ைலளகலளக் கூறு. 

 ➢ லைன் (Line) கட்ைலளலயப் பயன்படுத்தி மகாடுகள் வலரயைாம். 

➢ சர்க்கிள் (Circle) கட்ைலளலயப் பயன்படுத்தி ஒரு வட்ைம் வலரய முடியும். 

➢ தரக்ைாங் (Rectang) கட்ைலளலயப் பயன்படுத்தி சரியான மகாண 

அளவுகளுைன் ஒரு தசவ்வகத்லே வலரய முடியும். 

 

2 விலசப்பைலக மூைம் LINE, CIRCLE ேற்றும் ERASE மபான்ற கட்ைலளகலள 

எவ்வாறு விலரவாக உள்ளிைைாம்? 

 LINE 

➢ லைன் (LINE) கட்ைலளலய கட்ைலள வரியில் LINE கட்ைலளலய 

உள்ளிைைாம். எ.கா.  

➢ பின்னர் ஆரம்ப x ேற்றும் y ஆயத்தோலைவுகலளக் தகாடுக்க மவண்டும். 

பின்னர் முடிவு ஆயத்தோலைவுகலளக் தகாடுக்க மவண்டும். 

CIRCLE 

➢ கட்ைலள வரியில் CIRCLE அல்ைது C என ேட்ைச்சு தசய்யவும். 

➢ லேயப்புள்ளிகலள தகாடுக்க மவண்டும். 

➢ விட்ைத்லே உள்ளிை D எனத் ேட்ைச்சு தசய்யவும். 

➢ விட்ைத்தின் அளலவ ேட்ைச்சு தசய்யவும். 

ERASE 

➢ கட்ைலள வரியில் Erase அல்ைது E என ேட்ைச்சு தசய்யவும். 

➢ அழிக்க மவண்டிய தபாருளின் மீது pickboxஐ லவத்து கிளிக் தசய்ய 

மவண்டும். தபாருளுலைய மகாட்டின் ேடிேன் தவளிர் சாம்பல் நிறத்திற்கு 

ோறும் 

➢ அழிக்க மவண்டிய அலனத்து தபாருள்கலளயும் தோைர்ந்து 

மேர்ந்தேடுக்கைாம்.  

 

3 LINE கட்ைலளயில் உள்ள Undo மேர்வின் பயன்கலள எழுதுக. 

 ➢ ஒரு மகாடு வலரயும் மபாது முடிவுப் புள்ளிலயத் ேவறாகக் 

குறிப்பிட்டுவிட்ைால், Undo கட்ைலள மூைம் கலைசியாகக் குறிப்பிட்ை 

புள்ளிலய நீக்கிவிட்டு, முந்லேய கட்ைத்திற்குச் தசல்ைைாம்.  
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➢ இந்ேக் கட்ைலளலய பைமுலற பயன்படுத்ே முடியும்.  

➢ இந்ே விருப்பத்லேப் பயன்படுத்ே கட்ைலள வரியில் Undo அல்ைது U எனத் 

ேட்ைச்சு தசய்ய மவண்டும்.  

➢ சுட்டிலய வைது கிளிக் தசய்து மோன்றும் பட்டியலில் உள்ள Undo 

விருப்பத்லேத் மேர்ந்தேடுத்தும் இலேச் தசய்யைாம். 

 

4 வட்ைங்கலள உருவாக்கும் பின்வரும் முலறகலள சுருக்கோக விவரி.  

Centre and radius  

Centre and diameter 

 Centre and radius  

➢ ரிப்பனில் Home > Draw > Circle > Center, Radius என்ற வரிலசயில் கிளிக் 

தசய்யவும்.  

➢ லேயப்புள்ளிலய குறிப்பிை, வலரகலை சன்னல் திலரயில் ஆர்பிட்ைரி 

பாய்ன்ட்லை (Arbitrary Point) மேர்ந்தேடுக்கவும்.  

➢ ஆரத்தின் அளலவ உள்ளிட்டு நுலைவு விலசலய அழுத்ேவும். 

 

 Centre and diameter 

➢ ரிப்பனில் Home > Draw > Circle > Center, Diameter என்ற வரிலசயில் கிளிக் 

தசய்யவும்.  

➢ கட்ைலள வரியில் CIRCLE அல்ைது C என ேட்ைச்சு தசய்யவும் 

➢ கட்ைலள வரியில் லேயப்புள்ளிலய (x ேற்றும் y) குறிப்பிட்டு நுலைவு 

விலசலய அழுத்ேவும். 

➢ விட்ை ேதிப்பிலன ேட்ைச்சு தசய்து நுலைவு தபாத்ோலன அழுத்ே 

மவண்டும். 

பகுதி - ஈ 

IV ஒரு பக்க அளவில் விலையளிக்கவும் 

  

3 தரக்ைாங்கல் தபாருலளப் பற்றி எழுதுக. ஆட்மைாமகடில் தசவ்வகம் 

வலரவேற்கான வழிமுலறகலளக் கூறு. 

 

 தசவ்வகம்: 

➢ லைன் கட்ைலளலயப் பயன்படுத்தியும் தசவ்வகம் வலரய முடியும். அதில் 

சிை குலறபாடுகள் உள்ளன.  

➢ மகாண அளவுகள் 90 டிகிரி உள்ளனவா என சரிபார்க்க மவண்டும்.  

➢ மேலும் ஒவ்தவாரு மகாடும் ேனித்ேனி தபாருளாக இருக்கும். ஒரு 

மகாட்டின் மீது கிளிக் தசய்ோல் அந்ே மகாடு ேட்டுமே மேர்வு தசய்யப்படும். 

ேற்ற மகாடுகள் மேர்வு தசய்யப்பைாது.  

➢ ஆட்மைாமகட் 2016இல் உள்ள RECTANG கட்ைலள, சரியான மகாண 

அளவுகளுைன் ஒரு தசவ்வகத்லே ஒமர தபாருளாக வலரய வழி 

வகுக்கிறது.  

➢ RECTANG கட்ைலளலயப் பயன்படுத்தி வலரயப்பட்ை தசவ்வகத்தின் 

எந்ேதவாரு இைத்திலும் கிளிக் தசய்து முழு தசவ்வகத்லேயும் 

மேர்ந்தேடுக்க முடியும். 
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சுட்டுக்குறியின் மூைம் தசவ்வகத்தின் முலனகலளத் மேர்ந்தேடுத்து தசவ்வகம் 

வலரேல் 

1. Command: RECTANG (அல்ைது) REC (நுலைவு விலசலய அழுத்ேவும்).  

2. கட்ைலள வரியில் கீழ்க்கண்ைவாறு மோன்றும்.  

RECTANGLE Specify first corner point or [Chamfer/ 

Elevation/Fillet/Thickness/Width]:  

3. தசவ்வகத்தின் முேல் முலன (P1) வலரய மவண்டிய இைத்திற்கு 

சுட்டுக்குறிலய நகர்த்தி சுட்டியின் இைது தபாத்ோலனக் கிளிக் தசய்யவும்.  

4. கட்ைலள வரியில் கீழ்க்கண்ைவாறு மோன்றும்.  

Specify other corner point or [Area / Dimensions / Rotatio]:  

5. தசவ்வகத்தின் முேல் முலனயிலிருந்து சுட்டிலய மூலைவிட்ைம் வழியாக 

நகர்த்தி, ேறுமுலனயில் (P2) சுட்டியின் இைது தபாத்ோலனக் கிளிக் 

தசய்யவும்.  

6. இப்தபாழுது தசவ்வகம் வலரயப்பட்டிருக்கும். 
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1. மபஜ்மேக்கர் - ஆவணத்லே வடிவலேத்ேல் 

வினா  

(a) மபஜ்மேக்கலரத் திறந்து கீழ்க்கண்ை அளவுகளுைன் கூடிய ஒரு புதிய ஆவணத்லே 

உருவாக்கவும். பக்க அளவு - A4 பக்கங்களின் எண்ணிக்லக - 4 மேல் பக்க ஓரம் 1.25 

அங்குைம் ேற்ற பக்கங்கள் 0.75 அங்குைம்  

(b) கீழ்க்கண்ை உலரலய உள்ளிைவும்.  

HAPPINESS Happiness is often confused with fun, good living, and riches. Sometimes fun is equated 

with happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires life-

long pursuit. 

(c) HAPPINESS என்னும் ேலைப்பிற்கு எழுத்து வலகயின் அளவு 18 புள்ளிகள், எழுத்து 

வலக Arial, ேடிேன், லேய இலசவு ஆகிய வடிவூட்ைல்கலளச் தசய்க.  

(d) பத்திக்கு கீழ்க்கண்ை வடிவூட்ைல்கலளச் தசய்க. (a) Font - Arial (b) Font size - 12 (c) 

Alignment – Justified (d) Leading – 20  

(e) ஆவணத்லே ‘happiness’ என்ற தபயரில் மசமிக்க. 

மபஜ்மேக்கர் - ஆவணத்லே வடிவலேத்ேல் 

மநாக்கம் : 

மபஜ்மேக்கலரத் திறந்து தகாடுக்கப்பட்ை அளவுகளுைன் கூடிய ஒரு புதிய 

ஆவணத்லே உருவாக்குேல். 

தசய்முலற : 

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 என்ற 

வரிலசயில் கிளிக் தசய்து ஒரு புதிய மபஜ்மேக்கர் ஆவணத்லேத் திறக்கவும். 

2.  பட்டிப்பட்லையில் File > New என்பலேக் கிளிக் தசய்யவும். (அல்ைது) Ctrl + N 

என்னும் விலசப்பைலக குறுக்கு வழிலயப் பயன்படுத்ேவும். இது Document Setup 

உலரயாைல் தபட்டிலயத் திறக்கும். 

• Page Size கீழிறங்கு பட்டிப்தபட்டியில் கிளிக் தசய்து A4 என்னும் பக்க 

அளலவத் மேர்ந்தேடுக்கவும். 

• Number of pages உலரப்தபட்டியில் 4 என உள்ளிைவும். 

• ஓரங்களின் அளலவ கீழ்க்கண்ைவாறு ோற்றவும்.  

Inside – 0.75 inches    

Outside – 0.75 inches  

Top – 1.25 inches  

Bottom – 0.75 inches 

3. OK தபாத்ோலன கிளிக் தசய்யவும். Untitled – 1 என்ற தபயரில் புதிய ஆவணம் 

திலரயில் மோன்றும். 
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4. தைக்ஸ்ட் டூலைக் கிளிக் தசய்து ஒரு உலரத்தோகுதிலய உருவாக்கவும். பிறகு 

கீமை தகாடுக்கப்பட்டுள்ள உலரலய ேட்ைச்சு தசய்யவும். HAPPINESS 

 Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with 

happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness 

requires life-long pursuit. 

5. தைக்ஸ்ட் டூலைக் தகாண்டு ‘HAPPINESS’ என்பலேத் மேர்ந்தேடுக்கவும். Character 

Control Palette மூைம் எழுத்து வலக Arial, எழுத்து வலகயின் அளவு 18 புள்ளிகள், 

Leading 22 என ோற்றவும். Bold தபாத்ோலனக் கிளிக் தசய்யவும். பிறகு லேய 

இலசவிற்கு Shift + Ctrl + C என்னும் சாவி மசர்ோனத்லே அழுத்ேவும். 

6. தைக்ஸ்ட் டூலைக் தகாண்டு பத்திலயத் மேர்ந்தேடுக்கவும். Character Control Palette 

மூைம் எழுத்து வலக Arial, எழுத்து வலகயின் அளவு 12 புள்ளிகள், Leading 20 என 

ோற்றவும். பிறகு மநர்த்தி இலசவிற்கு Shift + Ctrl + J என்னும் சாவி மசர்ோனத்லே 

அழுத்ேவும். 

7. ஆவணத்லே ‘happiness’ என்ற தபயரில் மசமிக்க விலசப்பைலகயில் Ctrl + S 

என்பலே அழுத்ேவும் அல்ைது பட்டிப்பட்லையில் File > Save என்பலேக் கிளிக் 

தசய்யவும். Save publication உலரயாைல் தபட்டி மோன்றும். File name 

உலரப்தபட்டியில் ‘happiness’ என ேட்ைச்சு தசய்து Save தபாத்ோலனக் கிளிக் 

தசய்யவும். 

 

தவளியீடு: 

HAPPINESS 

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with 

happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness 

requires life-long pursuit.  

முடிவு : 

 எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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3. மபஜ்மேக்கர் - விசிட்டிங் கார்லை உருவாக்குேல் 

வினா  

மபஜ்மேக்கலரப் பயன்படுத்தி கீழ்க்கண்ை விசிட்டிங் கார்லை உருவாக்க 

 

 

மபஜ்மேக்கர் - விசிட்டிங் கார்லை உருவாக்குேல் 

மநாக்கம் : 

மபஜ்மேக்கலரப் பயன்படுத்தி தகாடுக்கப்பட்டுள்ள விசிட்டிங் கார்லை 

உருவாக்குேல். 

தசய்முலற : 

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 என்ற 

வரிலசயில் கிளிக் தசய்து ஒரு புதிய மபஜ்மேக்கர் ஆவணத்லேத் திறக்கவும். 

2. பட்டிப்பட்லையில் File > New என்பலேக் கிளிக் தசய்யவும். (அல்ைது) Ctrl + N 

என்னும் விலசப்பைலக குறுக்கு வழிலயப் பயன்படுத்ேவும். இது Document Setup 

உலரயாைல் தபட்டிலயத் திறக்கும். 

3. OK தபாத்ோலன கிளிக் தசய்யவும். Untitled – 1 என்ற தபயரில் புதிய ஆவணம் 

திலரயில் மோன்றும். 

4. இப்தபாழுது அளவீடுகலள Inches லிருந்து Millimetersக்கு ோற்றவும்.  

பட்டிப்பட்லையில் File > Preferences > general என்ற கட்ைலளலயக் கிளிக் 

தசய்யவும். (அல்ைது) விலசப்பைலகயில் Ctrl + K என்பலே அழுத்ேவும்.  

இப்தபாழுது Preferences உலரயாைல் தபட்டி மோன்றும்.  

அதில் Measurements ேற்றும் Vertical ruler கீழிறங்கு பட்டிப்தபட்டியில் Millimeters 

என்பலேத் மேர்ந்தேடுக்கவும். 

5. கருவிப் தபட்டியிலிருந்து தரக்ைாங்கல் டூலைத் மேர்ந்தேடுத்து தசவ்வகம் 

வலரயவும் 

6. Control Palette இல் width 95 mm எனவும் height 55 mm எனவும் ோற்றவும். 

7. கருவிப்தபட்டியில் தைக்ஸ்ட் டூலை கிளிக் தசய்யவும். ேட்ைச்சு தசய்ய மவண்டிய 

உலரயின் எல்லைலயக் குறிப்பிை தசவ்வகத்தின் இைது மூலையிலிருந்து வைது 

மூலை வலர கிளிக் தசய்து இழுக்கவும்.  

8. நபரின் தபயலர உள்ளிட்டு, அலே தைக்ஸ்ட் டூல் மூைம் மேர்ந்தேடுக்கவும். Control 

Palette மூைம் மேலவயான எழுத்து வலக ேற்றும் எழுத்தின் அளலவக் 

தகாடுக்கவும். பின்னர் வைது புறோக சிறிது நகர்த்ேவும். 
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9. படிநிலை 7 ஐ ேறுபடியும் தசய்யவும். நிறுவனத்தின் தபயலர உள்ளிட்டு, அலே 

தைக்ஸ்ட் டூல் மூைம் மேர்ந்தேடுக்கவும். Control Palette மூைம் மேலவயான எழுத்து 

வலக ேற்றும் எழுத்தின் அளலவக் தகாடுக்கவும். பின்னர் வைது புறோக சிறிது 

நகர்த்ேவும். முேல் எழுத்லே தைக்ஸ்ட் டூல் மூைம் மேர்ந்தேடுத்து எழுத்து 

வலகயின் அளலவ தபரிோக்கவும். 

10. படிநிலை 7 ஐ ேறுபடியும் தசய்யவும். நிறுவனத்தின் முகவரிலய உள்ளிட்டு, அலே 

தைக்ஸ்ட் டூல் மூைம் மேர்ந்தேடுக்கவும். Control Palette மூைம் மேலவயான எழுத்து 

வலக ேற்றும் எழுத்தின் அளலவக் தகாடுக்கவும். பின்னர் வைது புறோக சிறிது 

நகர்த்ேவும். 

தவளியீடு: 

 
முடிவு: 

 எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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4. மபஜ்மேக்கர் - ஒரு மைபிலள (Label) உருவாக்குேல் 

 

வினா  

மபஜ்மேக்கலரப் பயன்படுத்தி கீழ்க்கண்ை மைபிலள (Label) உருவாக்கு. 

 

மபஜ்மேக்கர் - ஒரு மைபிலள (Label) உருவாக்குேல் 

மநாக்கம் : 

மபஜ்மேக்கலரப் பயன்படுத்தி தகாடுக்கப்பட்டுள்ள மைபிலள (Label)  உருவாக்குேல். 

தசய்முலற : 

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 என்ற 

வரிலசயில் கிளிக் தசய்து ஒரு புதிய மபஜ்மேக்கர் ஆவணத்லேத் திறக்கவும். 

2.  பட்டிப்பட்லையில் File > New என்பலேக் கிளிக் தசய்யவும். (அல்ைது) Ctrl + N 

என்னும் விலசப்பைலக குறுக்கு வழிலயப் பயன்படுத்ேவும். இது Document Setup 

உலரயாைல் தபட்டிலயத் திறக்கும். 

3. OK தபாத்ோலன கிளிக் தசய்யவும். Untitled – 1 என்ற தபயரில் புதிய ஆவணம் 

திலரயில் மோன்றும். 

4. பிறகு அளவீடுகலள Inches லிருந்து Millimeters க்கு ோற்ற மவண்டும்.  

பட்டிப்பட்லையில் File > Preferences > general என்ற கட்ைலளலயக் கிளிக் 

தசய்யவும்.  

அதில் Measurements ேற்றும் Vertical ruler கீழிறங்கு பட்டிப்தபட்டியில் Millimeters 

என்பலேத் மேர்ந்தேடுக்கவும்.  

5.  கருவிப்தபட்டியிலிருந்து தரக்ைாங்கல் டூலைத் மேர்ந்தேடுத்து தசவ்வகம் 

வலரயவும்.  

6.  Control Palette இல் width 100 mm எனவும் height 40 mm எனவும் ோற்றவும். 

7.  பட்டிப்பட்லையில் Element > Rounded corners என்பலேக் கிளிக் தசய்யவும்.  

8. Rounded corners உலரயாைல் தபட்டியிலிருந்து மேலவயான வடிவத்லேத் 

மேர்ந்தேடுக்கவும். இப்தபாழுது வட்ைமுலன தசவ்வகம் மோன்றும்.  

9. கருவிப்தபட்டியில் தைக்ஸ்ட் டூலைக் கிளிக் தசய்து, தசவ்வகத்திற்குள் ஒரு 

உலரத்தோகுதிலய உருவாக்கவும்.  

10. Name : என்பலேத் ேட்ைச்சு தசய்து நுலைவு விலசலய அழுத்ேவும். 

STD : என்பலேத் ேட்ைச்சு தசய்து நுலைவு விலசலய அழுத்ேவும்.  

Section : என்பலேத் ேட்ைச்சு தசய்து நுலைவு விலசலய அழுத்ேவும்.  

School : என்பலேத் ேட்ைச்சு தசய்து நுலைவு விலசலய அழுத்ேவும்.  

Subject : என்பலேத் ேட்ைச்சு தசய்து நுலைவு விலசலய அழுத்ேவும்.  
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11. தைக்ஸ்ட் டூலைக் தகாண்டு உலர முழுவலேயும் மேர்ந்தேடுக்கவும்.  

12. பட்டிப்பட்லையில் Type > Indents / Tabs என்பலேக் கிளிக் தசய்யவும். (அல்ைது) 

விலசப்பைலகயில் Ctrl + I என்பலே அழுத்ேவும்.  

13. வைது tab ஐ 90 mm அளவில் தபாருத்ேவும். leader தபாத்ோலனக் கிளிக் தசய்து 

வரும் பட்டியலில் புள்ளிக்மகாட்லைத் மேர்ந்தேடுக்கவும். பின்னர் Apply 

தபாத்ோலனக் கிளிக் தசய்யவும். 

14. இப்தபாழுது மேலவயான மைபிள் உருவாக்கப்பட்டிருக்கும். 

தவளியீடு: 

 

முடிவு: 

 எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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5. மகாரல்ட்ரா - என்வைப் டூலைப்(Envelope tool) பயன்படுத்தி உலரயின் 

வடிவத்லே ோற்றுேல் 

வினா : 

மகாரல்ட்ராலவப் பயன்படுத்தி கீமை தகாடுக்கப்பட்டுள்ள உலரலய உருவாக்கு. 

 

மநாக்கம்: 

என்வைப் டூலைப்(Envelope tool) பயன்படுத்தி தகாடுக்கப்பட்டுள்ள உலரலய 

உருவாக்குேல். 

தசய்முலற 

1. Start >All Programs > CorelDRAW Graphics Suite 2018 > CorelDRAW 2018 என்ற 

வரிலசயில் கிளிக் தசய்து மகாரல்ட்ராலவத் திறக்கவும்.  

2. Welcome Screen சன்னல் திலரயில் New Document தபாத்ோலனக் கிளிக் தசய்யவும். 

3. இப்தபாழுது Create a New Document உலரயாைல் தபட்டி மோன்றும்.  

4. அதில் Ok தபாத்ோலனக் கிளிக் தசய்யவும்.  

5. தைக்ஸ்ட் டூலைக் கிளிக் தசய்யவும். (அல்ைது) விலசப்பைலகயில் F8 விலசலய 

அழுத்ேவும்.  

6. “DesktopPublishing” என்னும் உலரலயத் ேட்ைச்சு தசய்யவும்.  

7. Pick டூலைக் கிளிக் தசய்து உலரலயத் மேர்ந்தேடுக்கவும்.  

8. என்வைப் டூலில் கிளிக் தசய்யவும்.  

9. மேல் லேயப் புள்ளிலய மேல் மநாக்கி நகர்த்ேவும். அமே மபான்று கீழ் 

லேயப்புள்ளிலயயும் மேல் மநாக்கி நகர்த்ேவும்.  

தவளியீடு: 

 

முடிவு: 

எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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7. ஆட்மைாமகட் - ேனித்ே ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி 

பைம் வலரேல் 

வினா  

கீமை உள்ள அட்ைவலணயில் தகாடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ேனித்ே 

ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரக 

 

ஆட்மைாமகட் - ேனித்ே ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி பைம் வலரேல் 

மநாக்கம்: 

 அட்ைவலணயில் தகாடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ேனித்ே ஆயத்தோலைவு 

அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரேை 

தசய்முலற 

1. திலரயிலுள்ள AutoCAD 2016-English பணிக்குறிலய இருமுலற கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும். (அல்ைது) Start >All Programs > Autodesk > 

AutoCAD 2016 > AutoCAD 2016-English என்ற வரிலசயில் கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும்.  

2. Drafting&Animation பணித்ேளத்திலிருந்து முன்வடிவலேக்கப்பட்ை மகாப்பான acad. 

dwt என்பலே கிளிக் தசய்து ஒரு புதிய மகாப்லப உருவாக்கவும்.  

3. உைவுேல் பட்லையிலிருந்து Zoom All டூலைத் மேர்ந்தேடுக்கவும்.  

4. நிலைலேப் பட்லையிலுள்ள Grid ஐ OFF தசய்யவும்.  

5. லைனமிக் இன்புட் மோலை OFF தசய்யவும்.  

6. ரிப்பனில் Home > Draw > Line என்ற வரிலசயில் கிளிக் தசய்யவும். (அல்ைது) 

கட்ைலள வரியில் LINE அல்ைது L எனத் ேட்ைச்சு தசய்யவும். கீமை 

தகாடுக்கப்பட்டுள்ளவாறு கட்ைலள வரியில் புள்ளிகலள ேட்ைச்சு தசய்யவும். 
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Command: LINE↵  

Specify first point: 55,100↵  

Specify next point or [Undo]: 120,100↵  

Specify next point or [Undo]: 120,70↵ 

Specify next point or [Close/Undo]: 230,70↵  

Specify next point or [Close/Undo]: 230,100↵  

Specify next point or [Close/Undo]: 295,100↵  

Specify next point or [Close/Undo]: 295,210↵  

Specify next point or [Close/Undo]: 275,235↵  

Specify next point or [Close/Undo]: 80,235↵  

Specify next point or [Close/Undo]: 55,210↵  

Specify next point or [Close/Undo]: C↵  

7. Line-example1.dwg என்ற தபயரில் மகாப்லப மசமிக்கவும். 

தவளியீடு: 

 

முடிவு: 

எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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8. ஆட்மைாமகட் ஒப்பீடு தசவ்வக ஆயத்தோலைலவ அலேப்லப 

பயன்படுத்தி பைம் வலரேல் 

வினா  

கீமை உள்ள அட்ைவலணயில் தகாடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு 

தசவ்வக ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரக 

 

ஆட்மைாமகட் ஒப்பீடு தசவ்வக ஆயத்தோலைலவ அலேப்லப பயன்படுத்தி பைம் 

வலரேல் 

மநாக்கம் :  

அட்ைவலணயில் தகாடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு தசவ்வக 

ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரேல். 

தசய்முலற  

1. திலர முகப்பிலுள்ள AutoCAD -2016English பணிக்குறிலய இருமுலற கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும். (அல்ைது) Start >All Programs > Autodesk > 

AutoCAD 2016 > AutoCAD 2016-English என்ற வரிலசயில் கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும்.  

2. Drafting&Animation பணித்ேளத்திலிருந்து முன்வடிவலேக்கப்பட்ை மகாப்பான acad. 

dwt என்பலே கிளிக் தசய்து ஒரு புதிய மகாப்லப உருவாக்கவும்.  

3. உைவுேல் பட்லையிலிருந்து Zoom All டூலைத் மேர்ந்தேடுக்கவும்.  

4. நிலைலேப் பட்லையிலுள்ள Grid ஐ OFF தசய்யவும்.  

5. லைனமிக் இன்புட் மோலை OFF தசய்யவும்.  
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6. ரிப்பனில் Home > Draw > Line என்ற வரிலசயில் கிளிக் தசய்யவும். (அல்ைது) 

கட்ைலள வரியில் LINE அல்ைது L எனத் ேட்ைச்சு தசய்யவும்.  

7. கீமை தகாடுக்கப்பட்டுள்ளவாறு கட்ைலள வரியில் புள்ளிகலள ேட்ைச்சு தசய்யவும்.  

Command: LINE↵  

Specify first point: 100,100 ↵  

Specify next point or [Undo]: @50,0 ↵  

Specify next point or [Undo]: @0,20 ↵  

Specify next point or [Close/Undo]: @100,0 ↵  

Specify next point or [Close/Undo]: @0,-20 ↵  

Specify next point or [Close/Undo]: @50,0 ↵  

Specify next point or [Close/Undo]: @0,120 ↵ 

Specify next point or [Close/Undo]: @-50,0 ↵  

Specify next point or [Close/Undo]: @0,-20 ↵  

Specify next point or [Close/Undo]: @-100,0 ↵  

Specify next point or [Close/Undo]: @0,20 ↵ 

Specify next point or [Close/Undo]: @-50,0 ↵  

Specify next point or [Close/Undo]: c ↵  

8. Line-example2.dwg என்ற தபயரில் மகாப்லப மசமிக்கவும். 

தவளியீடு: 

 

முடிவு  

எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது 
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9. ஆட்மைாமகட் ஒப்பீடு துருவ ஆயத்தோலைலவ அலேப்லப பயன்படுத்தி 

பைம் வலரேல் 

வினா  

கீமை உள்ள அட்ைவலணயில் தகாடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு துருவ 

ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரக 

 

ஆட்மைாமகட் ஒப்பீடு துருவ ஆயத்தோலைலவ அலேப்லப பயன்படுத்தி பைம் 

வலரேல் 

மநாக்கம்  

அட்ைவலணயில் தகாடுக்கப்பட் டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு துருவ 

ஆயத்தோலைவு அலேப்லபப் பயன்படுத்தி ஒரு பைம் வலரேல்.  

தசய்முலற  

1. திலர முகப்பிலுள்ள AutoCAD -2016English பணிக்குறிலய இருமுலற கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும். (அல்ைது) Start >All Programs > Autodesk > 

AutoCAD 2016 > AutoCAD 2016-English என்ற வரிலசயில் கிளிக் தசய்து 

ஆட்மைாமகட் 2016ஐ திறக்கவும்.  

2. Drafting&Animation பணித்ேளத்திலிருந்து முன்வடிவலேக்கப்பட்ை மகாப்பான 

acad.dwt என்பலே கிளிக் தசய்து ஒரு புதிய மகாப்லப உருவாக்கவும்.  

3. உைவுேல் பட்லையிலிருந்து Zoom All டூலைத் மேர்ந்தேடுக்கவும். 

4. நிலைலேப் பட்லையிலுள்ள Grid ஐ OFF தசய்யவும். 

5. லைனமிக் இன்புட் மோலை OFF தசய்யவும்.  

6. ரிப்பனில் Home > Draw > Line என்ற வரிலசயில் கிளிக் தசய்யவும். (அல்ைது) 

கட்ைலள வரியில் LINE அல்ைது L எனத் ேட்ைச்சு தசய்யவும். கீமை 

தகாடுக்கப்பட்டுள்ளவாறு கட்ைலள வரியில் புள்ளிகலள ேட்ைச்சு தசய்யவும்.  
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Command: LINE↵  

 

தவளியீடு 

 

முடிவு  

எதிர்பார்க்கப்பட்ை முடிவு கிலைத்ேது. 
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